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1. Introduction XE "introduction" 
Clinical Procedures (CP) is a new VistA package that provides features that can be used across clinical departments, such as general medicine, cardiology, pulmonary, women’s health, neurology, and rehabilitation medicine. CP is a conduit for passing patient results, using HL7 messaging, between the vendor and VistA.  Patient test results are displayed in the Computerized Patient Record System (CPRS).  CP includes three modules, which are CP User, CP Manager, and CP Gateway.

CP User is the primary application that clinicians use.  For example, you can place an order for a procedure, such as an EKG, through the Consults tab or Orders tab in CPRS, or Order Entry.   Then you can use CP User to check in a patient and initiate the actual procedure. If the procedure is performed on a bi-directional instrument, the patient demographics are automatically transmitted to the instrument.  When the procedure is complete, the result is transmitted back to VistA Imaging and attached to a TIU note/document that is associated with the original procedure order.

If the procedure is performed on a uni-directional instrument, you use CP User to match the instrument results to the requested procedure.  The TIU note is created when the instrument results are submitted to VistA Imaging.  Standard Consults functionality is used to complete and sign the TIU note.  The main purpose of CP User is to link the results from the automated instrument to the procedure ordered through Consults in CPRS.
System managers and clinical application coordinators use CP Manager.  The main purpose of this application is to add and edit automated instruments and procedures in the CP database.  CP Manager is also used to configure the site files and required system parameters.  
CP Gateway manages the flow of information from the instrument interfaces to CPRS. CP Gateway polls the system regularly for new data from instruments and processes this data into usable attachments for the VistA Imaging system.  

Topics discussed in this chapter are:

· Intended Audience
· Related Manuals
· Product Benefits
The following pages contain flowcharts explaining the bi-directional and uni-directional Clinical Procedures process flow.

Clinical Procedures Bi-Directional Interface Process Flow: XE "process flow diagrams" 


















































Clinical Procedures Uni-Directional Interface Process Flow:

















































Intended Audience XE "intended audience" 
This User Manual is intended for use by clinicians, physicians, nurses, technicians, TSO, and IRMS.  End users should be familiar with the following:

· Windows operating systems

· CPRS functionality

Related Manuals XE "related manuals" 
Here is a list of related manuals that you may find helpful:

Clinical Procedures Installation Guide

Clinical Procedures Technical Manual and Package Security Guide

Clinical Procedures Implementation Guide

Clinical Procedures Release Notes

CPRS User Manual

Consult/Request Tracking User Manual

Consult/Request Tracking Technical Manual

Text Integration Utilities (TIU) Implementation Guide

Text Integration Utilities (TIU) User Manual

VistA Imaging System (Clinical) User Manual

You can locate these manuals in the VistA Documentation Library (VDL). Select Clinical from the VDL web page, select the package you want, and then select the manuals.  For example, you can select CPRS on the left side of the page.  The list of CPRS manuals is displayed. 

Product Benefits XE "benefits" 
· Common User Interface

Clinicians can use CPRS to enter, review, interpret, and sign CP orders.  CP documents in TIU obey Authorization Subscription Utility (ASU) Business Rules.  The update users functionality currently used by Consults determines which users are allowed to access or edit CP documents.  

· Integration

Clinicians order procedures in CPRS.  Orders are processed through the Consult/Request Tracking Package (Consults) and data is interpreted, entered, and displayed through CPRS.  Final results of the CP procedure are displayed by VistA Imaging.  Ordering, viewing, reviewing, interpreting, and signing the CP medical record is accessed through one location, the CPRS Consults tab. You use CP User to check in patients. CP User also links the result from the automated instrument to the procedure ordered through Consults. 
· Variety of Accepted File Types XE "file types" 

 XE "imaging file types" 
CP is able to accept data/final result report files from automated instruments. The supported imaging file types are the following:


.txt 
Text files


.rtf
Rich text files


.jpg
JPEG Images


.jpeg
JPEG Images


.bmp
Bitmap Images


.tiff
TIFF Graphics (group 3 and group 4 compressed and uncompressed types)



.pdf
Portable Document Format


.html
Hypertext Markup Language 

.DOC (Microsoft Word files) are not supported. Be sure to convert .doc files to .rtf or to .pdf format.
· Links to Other Packages

CP interfaces with packages such as Computerized Patient Record System (CPRS), Consult/Request Tracking package, Text Integration Utility package (TIU), and VistA Imaging. 

· Interface Between CP and Imaging

Certain images such as consent forms and report objects are acquired, processed, stored, transmitted, and displayed by the VistA Imaging package.  This interface between CP and Imaging replaces the existing capture interface between Medicine 2.3 and VistA Imaging.

· Inpatient and Outpatient Workloads XE "hospital location" 

 XE "workload reporting" 
The Hospital Location, where the procedure is performed, is defined in the CP Definition file (#702.01).  The hospital location determines which Encounter Form is presented to the end user.  CPRS and TIU parameters allow for the configuration of TIU software to display the electronic encounter form and prompt users to enter workload data. The data is then passed to the Patient Care Encounter software (PCE) for inpatients and outpatients.  

2. Working with CP User XE "CP User" 
This chapter describes how to get started with CP User.

Topics discussed in this chapter are:

· Opening CP User
· Defining CP User Icons
· Selecting a Patient
· Defining the Parts of the Main CP User Window
Opening CP User XE "CP User:opening" 
With CP User, the result from the automated medical device is linked to the procedure that was ordered through the Consults tab.  

· Double-click CP User on your desktop.  If you are not currently logged into the VistA system, you need to enter your access and verify codes.  Click OK.  The main CP User window is displayed.

Defining CP User Icons XE "CP User:Icons" 
 Select View > Use Toolbar. 

[image: image2.bmp]  Open Patient – Opens a new patient record.

[image: image3.bmp]  Refresh Patient - Refreshes the currently selected patient’s information.

[image: image4.bmp]  Check-in New Study - Checks-in a patient and opens a new study.

[image: image5.bmp]  Open Study - Opens a currently selected study.

[image: image6.bmp]  Delete Study - Deletes a currently selected study.

[image: image7.bmp]  Help - Provides on-line help for this package.

[image: image8.bmp]  Clinical Procedures Home Page - Goes to the Clinical Procedures Home Page on the Web.

Selecting a Patient XE "patient:selecting in CP User" 

 XE "patient:selecting" 

 XE "CP User:selecting a patient" 
1. Open CP User. 


2. Select File > Open Patient.  The main CP User screen lets you select a patient that has a consult procedure ordered.  You can choose Patient, Team, Clinic, or Ward.

-
Choose Patient if you want to select a patient by name, complete SSN, or first initial of the last name and the last four digits of the SSN.

-
Choose Team if you want to select a patient from a specific team list defined in the OE/RR List file (#100.21).

-
Choose Clinic if you want to select a patient from selected clinic appointments for a predetermined clinic and date.

-
Choose Ward if you want to select a patient from selected MAS wards. 
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Fig. 2-1

3. Double-click the patient’s name.  A confirmation screen is displayed, which shows additional information about the selected patient.  See Figure 2-1.  If you select a sensitive patient, a sensitive patient window is displayed indicating that the patient’s information should only be accessed on a need to know basis. 

4. Click OK.  Figure 2-2, the main CP User window is displayed.

Defining the Parts of the Main CP User Window XE "defining the CP User window" 
In this main window, you can select a treating specialty from the left and view a list of procedures within that treating specialty on the right.  Click the column headers to sort them in ascending or descending order. 
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Fig. 2-2

The status column displays New, Submitted, Error, Ready to Complete, Pending Instrument Data, and Complete.  Here is a description of each status type in (Fig. 2-2). XE "status:types of" 

 XE "study status:types of" 
· New XE "new:status"  - (The New status is only available with VistA Imaging.)  A study has been requested by VistA Imaging and needs to be checked-in and submitted to an instrument.  Example: You scanned in a consent form through the VistA Imaging Capture Workstation.  A new CP Study record is created along with a TIU document. 

· Submitted XE "submitted:status"  - This study has been submitted to the VistA Imaging Background Processor.  The study report waits in the Imaging Background Processor queue to be copied or processed and placed on the VistA Imaging server.  A study in this status is not accessible until VistA Imaging returns a status of Complete or Error and logs any errors encountered in the submission process.

· Error -  XE "errors:status" This study has encountered an error while being submitted to VistA Imaging.  The error may have been caused when the TIU note was created, when a visit was created, when the results were linked to the procedure, or when the attachments were sent to the VistA Imaging server.  Error messages are logged with the study and can be reviewed by opening the study in an error status.   XE "status:error" 
· Complete XE "complete:status"  - This study has successfully created a TIU note for interpretation and images have been sent to VistA Imaging for the selected consult procedure order.  If any attachments were included, they have been successfully copied to the VistA Imaging server.   XE "status:complete" 
· Pending Instrument Data XE "pending instrument data:status"  – (This status is only valid for bi-directional instruments that have not returned results.)  The procedure request has been submitted to a bi-directional instrument and is waiting for the instrument to return the results.  Studies in this status should not be opened until the instrument has returned the results, assigned them to the study, and marked the study as Ready to Complete. 

- If the “Auto Submit to VistA Imaging” checkbox is selected for the associated procedure in CP Manager, the study goes to Complete.
- If the “Auto Submit to VistA Imaging” checkbox is not selected for the associated procedure in CP Manager, the study goes to Ready to Complete.


· Ready to Complete XE "ready to complete:status"  – 
When a study is done on a uni-directional instrument, the status displays as Ready to Complete. 

When a study is submitted to a bi-directional instrument, the study remains in Pending Instrument Data status and changes to Ready to Complete after the study has received the data from the instrument.  (Auto Submit to VistA Imaging is not selected.)   

In the Ready to Complete status, you can open the study, view the Consult/Procedure order, and manually submit instrument results and external attachments to VistA Imaging.  

 XE "study:deleting" 

 XE "deleting:study" A study can be deleted when it has a status of  “Pending Instrument Data” and the user has the MD Manager key.  A study should be deleted only if the study was sent to the wrong instrument, or if the patient was unable to complete the procedure.  Select File > Delete Study and click Delete.  A cancel order is sent to the device.  If that device is not working, you must manually delete the order from the device. Refer to the manual for your specific instrument for instructions on deleting an order.

3. Clinical Procedures Process, Part 1 XE "CP process" 
This chapter describes the process to follow for ordering clinical procedures. (Although you can order several types of procedures in CPRS, you must follow the steps in this chapter to order clinical procedures.)  This chapter uses the example of ordering a colonoscopy test to describe the Clinical Procedures ordering process.  Be sure to follow the required steps in sequential order. You can do the optional steps as needed.

1. Order a consult procedure in CPRS.  Required

2. Check in a new study.  Required

3. Update study status to correct errors. Optional

Ordering a Consult Procedure XE "CPRS:ordering a consult procedure"  in CPRS  XE "ordering:consult procedures" 

 XE "consult procedures:ordering" 
This section describes how to order a CP procedure, such as a study, a test, or an invasive intervention, such as a surgical or medical procedure, through CPRS. Keep in mind that you can only order a Clinical Procedure as a procedure order and not as a consult request. 
In addition to becoming familiar with the CPRS ordering process, you can learn about the interpreter, which is the new user role within ASU that supports CP.  The interpreter is a new User Role created by ASU that defines a user who can interpret (sign-off or verify) the procedure’s final report.  Clinical application coordinators define interpreters in the Consults package.  

If you are an interpreter for a specific procedure, you can receive an alert when the procedure results are ready for review. Additional comments can be added if necessary along with the Procedure Summary code and the electronic signature. The following example describes how to order a colonoscopy procedure through the CPRS Consults tab.  

1. Logon to CPRS.  The Patient Selection window is displayed, Figure 3‑1. 
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Figure 3‑1
2. Select a patient.  Notice that CPPATIENT, ONE is the selected patient.  The Cover Sheet window is displayed, Figure 3‑2. 
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Figure 3‑2
3. Click the Consults tab at the bottom of the window, Figure 3‑3. 
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Figure 3‑3
4. If you want to review an existing Consult or procedure, select one in the list from the upper left panel. The lower left panel contains any supporting documents for the selected consult or procedure, and the larger right panel contains the order details.   

5. Click New Procedure on the left side of the Consults tab.  You can also order a clinical procedure from the Orders tab.  Since CPPATIENT, ONE is an inpatient, the Order a Procedure window, Figure 3‑5, is displayed.  Go to step 7 to order the procedure.

(If you were to select an outpatient, Figure 3‑4displays so you can enter a location. Go to step 6.)
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Figure 3‑4
6. For Outpatients, select either the Clinic Appointments or New Visit tab.
- Select Clinic Appointments if the patient already has an appointment through Scheduling. 
- Select New Visit if an appointment has not been made through Scheduling, and then select a location from the list of Visit Locations. The Encounter Location is filled in automatically.
- If the patient had existing admissions, these are displayed under the Hospital Admissions tab. 
- Go to step 7 to order the procedure.
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Figure 3‑5
7. To order the colonoscopy procedure, select Colonoscopy from the Procedure dropdown list, Figure 3‑5.  

- Complete the appropriate fields. 
- Click Accept Order. 
- Click Quit. 

8. To sign the consult procedures, select File > Review/Sign Changes.  Figure 3‑6 is displayed.

- Click the appropriate check box to select the colonoscopy. 
- Enter your electronic signature code. 
- Click Sign to return to the Consults tab. At this point, the procedure order is completed.
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Figure 3‑6
9. Click the Orders tab to review the ordered procedures.  These procedure orders appear on the Active Orders sheet (Figure 3‑7).
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Figure 3‑7

Auto Study Check-In XE "Auto Study Check in" 

The auto study check in is a new enhancement introduced with patch MD*1.0*14.  The site can specify a procedure to have auto study check in using the MD AUTO CHECK-IN SETUP option.  Refer to the Clinical procedures Implementation Guide to set up a procedure for the auto study check-in.   This new functionality can be used if the site schedules an appointment for the patient or not.  If the site does not use appointments, the study will be checked in as soon as the order is requested in CPRS.  The status of the study will be “Pending Instrument Data.”  If the site uses appointments, the study will have a status of “New” until the day of the appointment and the status will change to “Pending Instrument Data.”
For procedures that require multiple encounters from the patient such as hemodialysis, respiratory therapy, and sleep studies, each encounter will generate a study check-in if there is an appointment scheduled for each encounter.  If no appointment is used, only the initial check-in will be auto checked-in and the additional encounters will still require manual check-in.
Once a procedure is set up to use the auto study check-in functionality in the MD CHECK-IN SETUP option, the software will check-in any existing order requests with the status of “PENDING,” “ACTIVE,” and “SCHEDULED” in the Consult Request Tracking package.

If you have set up a procedure for auto check-in, you can skip the section on Check in a new study.  The study will be checked-in for you when the order is requested in CPRS.
Note 1: If the patient is a no show, you must remove the study that was checked-in.  You can delete the check-in in CP User or you can cancel the procedure in CPRS.  If you cancel or discontinue the order in CPRS, the status of the CP study will be changed to “Cancelled”.  If the appointment is rescheduled, the study will still need to be removed.

Note 2: Please make sure the studies are completed on time.  If a previous study is still in “Pending Instrument Data” or “Ready to Complete” status, the subsequent study check-in for the subsequent encounter will not be effective until the previous study is complete.

Note 3: In the case of an emergency procedure, the procedure will be performed prior to the order request.  The order request will be entered after the procedure and the study will be auto checked in.  You will need to attach the result manually as a uni-directional interface and submit the result.  Since the study is auto checked-in for the bi-directional device, you will need to clean up and remove the patient name from the selection list on the device.
In order to set up a procedure for auto-check-in, make sure you already have the procedure set up in Clinical Procedures and Consults/Request Tracking.  If your site is just implementing Clinical Procedures for the first time, set up the procedure and instrument for the regular Clinical Procedure interface before implementing the procedure for auto study check-in.

Auto Check-In Without Appointment XE "Auto Check-In Without Appointment" 
Once a procedure is set up to use the auto study check-in functionality, the software will check-in any existing order requests with the status of “PENDING,” “ACTIVE,” and “SCHEDULED” in the Consult Request Tracking package.
In this section, the following workflows are described:

· Setting Up the Procedure for auto study check-in.

· Procedure Request in CPRS.

· Confirming the auto study check-in

Setting Up the Procedure

Use the option MD AUTO CHECK-IN SETUP to indicate which procedure will use the auto check-in functionality.
Note: If your site uses appointments, schedule them before you enter the procedures for auto check-in.  If you do not, the patients associated with those appointments will need to be manually checked in.
This option collects the following information:

1) Use Appointment with procedure? (Yes/No) (Required) – The default is “NO” if the site does not schedule procedures before the order is entered.  Enter “YES” if the procedure appointment is scheduled before the order is entered and the ordering provider selects the appointment for the procedure during ordering in CPRS.  Take the default of “NO” if the provider sometimes selects the appointment scheduled and sometime doesn’t.  This prompt only applies to outpatients.

2) Procedure (Required) – Enter the CP Definition that will be using the auto study check-in functionality.

3) Schedule Appointment? (Required) – Enter 0 for None, 1 for Outpatient, 2 for Inpatient, or 3 for Both.  This indicates that the site schedules appointments for inpatient, outpatients, both, or none.

4) Clinic (Optional) – Enter the hospital location(s) that will be used for the scheduled procedure.  You can enter more than one location for a procedure.  After you have entered one hospital location, you will be asked if you want to enter another.

NOTE: If no clinic is entered in the setup, CP will use the hospital location defined in the HOSPITAL LOCATION field of the CP Definition file (#702.01) as the location of the visit for the CP study check-in.

In the following example, an EKG Routine (12 Leads) procedure is set up for auto study check-in.

Select OPTION NAME: MD AUTO CHECK-IN SETUP       Auto Study Check-In Setup

Auto Study Check-In Setup

Use Appointment with procedure? NO// ?

Default should be 'N' as most sites do not schedule procedures

before the order is entered.  Select 'Y' if the procedure appointment

is scheduled before the order is entered and the ordering provider

selects the appointment for the procedure.

Enter either 'Y' or 'N'.

Use Appointment with procedure? NO//
Procedure: ?

Enter a CP Definition for the procedure to

have auto CP study check-in.

 Answer with CP DEFINITION NAME

 Do you want the entire CP DEFINITION List? y  (Yes)

   Choose from:

   COL BIOPSY        

   COLONOSCOPY        

   EKG, ROUTINE (12 LEADS)        

   HEMODIALYSIS, REPEATED EVAL.        

   PULMONARY PROCEDURES        

Procedure: EKG, ROUTINE (12 LEADS)
Schedule Appointment?: ?

REQUIRED field for the procedure to have auto CP study check-in.

Enter a "^" will exit completely.

Enter 0 if you do not schedule appointments.

      1 if you only schedule appointments for outpatients.

      2 if you only schedule appointments for inpatients.

      3 if you schedule appointments for both 1 and 2.

     Select one of the following:

          0         None

          1         Outpatient

          2         Inpatient

          3         Both

Schedule Appointment?: 0  None
Procedure:
In the example shown above, the EKG Routine (12 Leads) is set up for auto check-in without an appointment involved.  The default of “NO” was entered for the question “Use Appointment with procedure?” and 0 was entered for the question “Schedule Appointment?”

Use CPManager.exe and verify for the EKG procedure that you have 1) the hospital location field filled in, 2) the Active checkbox is checked, and 3) One bi-directional instrument checkbox is checked.
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Figure 3‑8
Use CP Manager.exe and verify that the Muse EKG instrument is set up.  Use the Interface Analyzer button, check the instrument Muse EKG and click Analyze.  The Ready Status should be “Pass.”

Note:  Make sure the instrument is Active, has a Notification Mailgroup, and HL7 link.
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Figure 3‑9
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Figure 3‑10
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Figure 3‑11
Use the GMRC PROCEDURE SETUP to verify that EKG, ROUTINE (12 LEADS) is linked to a GMRC Procedure in Consult.

Select OPTION NAME: GMRC PROCEDURE SETUP       Setup procedures

Setup procedures

Select Procedure:CP EKG

     1   CP EKG 12 LEAD STAT  

     2   CP EKG INPATIENT,48 HRS, CONS CHOICE  

     3   CP EKG INPATIENT,STAT  

CHOOSE 1-5: 1  EKG 12 LEAD STAT

NAME: CP EKG 12 LEAD STAT// 

INACTIVE: NO// 

Select SYNONYM: EKG// 

INTERNAL NAME: 

Select RELATED SERVICES: CARDIOLOGY CLINIC// 

TYPE OF PROCEDURE: 

CLINICAL PROCEDURE: EKG, ROUTINE (12 LEADS)       

PREREQUISITE:

  1>

PROVISIONAL DX PROMPT: 

PROVISIONAL DX INPUT: 

DEFAULT REASON FOR REQUEST:

  1>

RESTRICT DEFAULT REASON EDIT: 

Orderable Item Updated
Procedure Request in CPRS
The procedure request is ordered and signed as you would for any other procedure in CPRS.
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Figure 3‑12
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Figure 3‑13
Confirm the Auto Study Check-In XE "Confirm the Auto Study Check-in" 
Once the procedure is requested and signed in CPRS, the study for the EKG procedure will be auto checked-in in CPUSER with the status of “Pending Instrument Data.”
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Figure 3‑14
Auto Study Check-In With Appointment XE "Auto Study Check-in With Appointment" 
If your site scheduled an appointment for the procedure, the study will be checked in and the study will not take into effect until the day of the appointment.

In this section, we will follow an example workflow of the auto study check-in for a procedure with appointment involved.  In the next example, the Pulmonary Procedure is used to show the setup of the procedure for auto check-in and both inpatient and outpatient have an appointment scheduled.

A new visit is not an appointment scheduled.  If your site only creates a new visit for the patient upon order request, it would not be considered an appointment scheduled.

Select OPTION NAME: MD AUTO CHECK-IN SETUP       Auto Study Check-In Setup

Auto Study Check-In Setup

Use Appointment with procedure? NO// ?

Default should be 'N' as most sites do not schedule procedures

before the order is entered.  Select 'Y' if the procedure appointment

is scheduled before the order is entered and the ordering provider

selects the appointment for the procedure.

Enter either 'Y' or 'N'.

Use Appointment with procedure? NO//
Procedure                  Schedule Appt.              Clinic

---------                  --------------              ------

EKG, ROUTINE (12 LEADS)    None                        None

Procedure: ?

Enter a CP Definition for the procedure to

have auto CP study check-in.

 Answer with CP DEFINITION NAME

 Do you want the entire CP DEFINITION List? y  (Yes)

   Choose from:

   COL BIOPSY        

   COLONOSCOPY        

   EKG, ROUTINE (12 LEADS)        

   HEMODIALYSIS, REPEATED EVAL.        

   PULMONARY PROCEDURES        
Procedure: PULMONARY PROCEDURES       
Schedule Appointment?: ?

REQUIRED field for the procedure to have auto CP study check-in.

Enter a "^" will exit completely.

Enter 0 if you do not schedule appointments.

      1 if you only schedule appointments for outpatients.

      2 if you only schedule appointments for inpatients.

      3 if you schedule appointments for both 1 and 2.

     Select one of the following:

          0         None

          1         Outpatient

          2         Inpatient

          3         Both

Schedule Appointment?: 3  Both

Clinic: ?

Only required, if appointments are scheduled for the procedure.

Enter the clinic used for scheduling the procedure.

 Answer with HOSPITAL LOCATION NAME, or ABBREVIATION, or TEAM

 Do you want the entire 112-Entry HOSPITAL LOCATION List? N

Clinic: PFT LAB
Enter another clinic for the same procedure? NO// ?
Enter either 'Y' or 'N', if you want to assign more than one clinic.
Enter another clinic for the same procedure? NO// YES
Clinic: SHIR
     1   SHIRL CLINIC       
     2   SHIRL-2       
CHOOSE 1-2: 2  SHIRL-2    
                           
Enter another clinic for the same procedure? NO// 
Procedure:
Use CPManager.exe and verify for the PULMONARY PROCEDURE that you have 1) left the hospital location field blank, 2) checked the Active checkbox, and 3) checked One Bi-directional instrument checkbox.

Note: The Hospital Location field is blank because the location of the appointment will be used for workload.

[image: image25.png]=lo/x|

Fle Tools Help

B C@BXS AWL | THE

i Long Stay Dia] _ Generel Alowable nstumerts
NhLangSAayM_‘ Rzt bl CLIRMVISION
Muse
NhLongSiayPi[FOLVONGRY PROCEDURES [agiver 12 |119%
hloro oS Ty Sty i e
ooStySe By | MuseHole
A O aepeenscrers
Nh Short Stay D1 Bl
Nnchon vy [FOLMORARYFORCIIONTEST | BLIMPUS Colooscny
Nh Shoit Stey P [~ Hosptal Losation 0] DLYMPUS EGDPEG
hShon Sty | [ | OLYMPUS o Uiarund
Nh Shot Stap B ] DLYMPUS Erteroscopy
Nhshort St 0] oLvPUS ERCP
y e Subit To Vi Tnaging T ] DLYMPUS Liver Biopsy
Nheu e r 0] OLYMPUS Paracentesis
Pedatics Signoidoscpy
Pt Transiion | Estermal Altachment Diectry MC
Pyeh Resd Fet [=|
Peychiatic Db
Peychialty
Pisd Residentil
&3 Pulmorary
Rehab Medicine
‘ >

[l ACKERMAN,NIEN-CHIN (COPLITER SPECIALIST) _ Divion: HINES 15





Figure 3‑15
Use CP Manager.exe and verify that the SMC instrument is set up.  Use the Interface Analyzer button and check the instrument SMC and click Analyze.  The Ready Status should be “Pass.”

Note:  Make sure the instrument is Active, has a Notification Mailgroup and an HL7 link.
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Figure 3‑16
Use the option “GMRC PROCEDURE SETUP” and verify the Pulmonary procedure is linked to a GMRC Procedure.  Add the text “Visit Date: |VISIT DATE|“ to the first line of the DEAFULT REASON FOR REQUEST field.

Select OPTION NAME: GMRC PRO

     1   GMRC PROCEDURE SETUP       Setup procedures

     2   GMRC PROTOCOL DETAILED REPORT       Detailed Report of GMRC Protocols

     3   GMRC PROTOCOL LIST       List GMRC Protocols

CHOOSE 1-3: 1  GMRC PROCEDURE SETUP     Setup procedures

Setup procedures

Select Procedure:CP PULMONARY FUNCTION TEST  

         ...OK? Yes//   (Yes)

NAME: CP PULMONARY FUNCTION TEST  Replace 

INACTIVE: NO// 

Select SYNONYM: PFT// 

INTERNAL NAME: 

Select RELATED SERVICES: PULMONARY// 

TYPE OF PROCEDURE: 

CLINICAL PROCEDURE: PULMONARY PROCEDURES       

PREREQUISITE:

  1>

PROVISIONAL DX PROMPT: OPTIONAL// 

PROVISIONAL DX INPUT: LEXICON// 

DEFAULT REASON FOR REQUEST:

  1>Visit Date: |VISIT DATE|

  2> 

  3>This is a Pulmonary Procedure.

RESTRICT DEFAULT REASON EDIT: 

Orderable Item Updated
The appointment can either be scheduled prior to the order request or after the order request.   The appointment has to be for a future date.  In the next two figures, they show a scheduled appointment to the Pft Lab for an outpatient and a scheduled appointment to Shirl-2 for an inpatient.

Appt Mgt Module               Dec 17, 2007@15:13:53          Page:    1 of    1 

Patient: TEST,D (4444)                        MT: REQ                 Outpatient

Total Appointment Profile        * - New GAF Required     11/17/07 thru 09/11/10

     Clinic                    Appt Date/Time        Status                     

 1   Pft Lab                   12/18/2007@10:00      Future                     

          Enter ?? for more actions                                             

CI  Check In              CD  Change Date Range     DX  Diagnosis Update

UN  Unscheduled Visit     EP  Expand Entry          DL  Wait List Display

MA  Make Appointment      AE  Add/Edit              DE  Delete Check Out

CA  Cancel Appointment    RT  Record Tracking       WD  Wait List Disposition

NS  No Show               PD  Patient Demographics  CP  Procedure Update

DC  Discharge Clinic      CO  Check Out             PC  PCMM Assign or Unassign

AL  Appointment Lists     EC  Edit Classification   TI  Display Team Information

PT  Change Patient        PR  Provider Update

CL  Change Clinic         WE  Wait List Entry

Select Action: Quit//
Appt Mgt Module               Dec 17, 2007@15:15:37          Page:    1 of    1 

Patient: TEST,NAJEE (8888)                    MT: NOT REQ              Ward: 3AS

Total Appointment Profile        * - New GAF Required     11/17/07 thru 09/11/10

     Clinic                    Appt Date/Time        Status                     

 1   Shirl-2                   12/18/2007@11:00      Inpatient/Future           

          Enter ?? for more actions                                             

CI  Check In              CD  Change Date Range     DX  Diagnosis Update

UN  Unscheduled Visit     EP  Expand Entry          DL  Wait List Display

MA  Make Appointment      AE  Add/Edit              DE  Delete Check Out

CA  Cancel Appointment    RT  Record Tracking       WD  Wait List Disposition

NS  No Show               PD  Patient Demographics  CP  Procedure Update

DC  Discharge Clinic      CO  Check Out             PC  PCMM Assign or Unassign

AL  Appointment Lists     EC  Edit Classification   TI  Display Team Information

PT  Change Patient        PR  Provider Update

CL  Change Clinic         WE  Wait List Entry

Select Action: Quit//
When you request an order for outpatient, you will be prompted for a visit.

If the ordering provider selects the appointment during ordering with the procedure, the appointment will be selected below.  Otherwise, a new visit is created.
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Figure 3‑17
If the GMRC Procedure is set up with the Visit Date text, the visit date/time should be visible in the Reason for Request field.  If the appointment is selected, the appointment date/time will be visible.

[image: image28.png]x

Procedae Ungency Atenion
[CP FULMONERY FUNCTION TEST =] [FOUTINE EN |

Service to pefom this prosedure Patient wilbe see 35 &1 | b of Congutation

[PULMONARY <] | Inpatient & Qupatient| [CONSULTANT'S CHOIL
ProvisionalDiscposis

A — Lung Neoplasms (1629) Lesicon

[isic pace: 12/17/07 14:23

This 15 a Pulmonary Procedure

CF PULHONARY FUNCTION TEST FULWGNARY Pioc CONSULTANTS =]

cHoice | Accept o out





Figure 3‑18
For the inpatient, the admission date/time will be visible in the Reason for Request field.

After the order is placed for both the inpatient and outpatient, the studies are checked-in for the Pulmonary Procedure in CPUser with the status of “New.”
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Figure 3‑19
The status changes to “Pending Instrument Data” on the day of the appointment.
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Figure 3‑20
Note 1: If the status of the study does not change to “Pending Instrument Data” upon the day of the appointment, have your IRM Support check if they scheduled the two options MD SCHEDULED STUDIES and MD STUDY CHECK-IN to run daily.

Note 2: If the procedure requires multiple encounters, the subsequent appointment scheduled will generate a study checked-in on the day of the appointment.  If you do not use appointments, it is recommended that you do not implement auto check-in for the procedure because you will need to manually check-in each subsequent encounter for the procedure.
Check-In XE "study:checking in"  a New Study  XE "checking in:studies" 
Checking in a new study is the next step in the Clinical Procedures process. You need to check in a new study in CP User after a procedure has been ordered. (Keep in mind that the CP check-in is not related to the Scheduling check-in process.)


If you want to link multiple results to one procedure, you can check in multiple studies for the same procedure that you ordered through Consults. A warning screen displays telling you that this consult procedure order has already been checked in (Figure 3‑22). After you ensure that you have the correct consult procedure order, you can continue to check in the study. In this way, you do not have to order multiple procedure requests.  In this example, the colonoscopy procedure was ordered and a new study for the colonoscopy procedure is being checked in.  

1. To check in a new study, first logon to CP User and select the patient.  Refer to Selecting a Patient, 2-2.
2. Choose File > Check in New Study to check in the patient.
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Figure 3‑21
3. Select a Consult procedure order for the selected patient. See Figure 3‑21.  The Clinical Procedure column lists the consult procedure orders.  Notice that the colonoscopy procedure is selected.

Note:  You can only select from Clinical Procedure request orders that are in the Pending (p), Scheduled (s), Partial Results (pr), Complete (c), and Active (a) statuses.  Discontinue (d) and Cancel statuses are excluded.  


If the consult procedure order you selected has already been checked in, a warning screen displays (Figure 3‑22). After you ensure that you have the correct consult procedure order, you can continue to check in the study.
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Figure 3‑22
4. Depending on the consult procedure you selected, the appropriate instruments for that procedure are displayed.  Click the appropriate instrument if more than one is listed, or click No Instrument if no instrument is associated with this procedure.  OLYMPUS is the appropriate instrument in this case and is selected. 

5. You must associate each CP study with a PCE visit, which is the hospital location where the procedure is performed.  Required.

For the majority of TIU notes created through CP, the visit association is completed in the background.  If a visit has already been recorded but the note wasn’t linked (standalone visits, such as telephone or walk-in visits), you can select a visit from the Clinical Procedures Check In edit screen (Figure 3‑21).  

To link the CP study to the visit, select information from the Outpatients Visits tab on Figure 3‑21. You can also select the New Visit tab and enter NOW for the date and time. 


6. Click Check-In. The main CP User window, Figure 3‑23, is displayed. 
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Figure 3‑23
7. If the study is checked-in for an instrument with a uni-directional interface, the status is Ready to Complete. If the study is checked-in for an instrument supported by a bi-directional interface, the status is Pending Instrument Data.  (Notice on Figure 3‑23, the colonoscopy status for 3/25 and 3/26 is Pending Instrument Data.)


8. At this point, the clinician performs the procedure on the instrument and transmits the results back to VistA.

If the instrument is bi-directional and the Auto Submit to VistA Imaging checkbox is selected for the procedure in CP Manager, the study status changes from Pending Instrument Data to Complete.  This occurs after the result has been transmitted to VistA, matched to the study, and copied over to VistA Imaging successfully.  The study is ready for interpretation.  At this time, the CP process is complete and attachments cannot be associated with this study.  See Clinical Procedures Process, Part 2.

If the instrument is uni-directional or if the instrument is bi-directional and the Auto Submit to VistA Imaging checkbox is not selected, the study status is Ready to Complete.  Go to the next step (9) to manually complete the CP process.

9. Open the study (Figure 3‑23) and add the instrument results and/or external attachments. You can only open studies that have an Error, Complete, Ready to Complete, or New status.  When a study is in the Ready to Complete or New status, you can open the study and finish entering any data that was missed.  An example of missed data is an external attachment that was not associated with the study. 
 

· Open this study and add results and/or external attachments. Click Open Study or select File > Open Study.  Figure 3‑24 is displayed.  


· Click +Results to select and submit the result to Vista Imaging. Only results for the patient and instrument used for the procedure are displayed. To select multiple results, hold down the CTRL key.  To select a range of results, highlight the initial result, hold down the Shift key, and then click the last result, Figure 3‑25.


· You can also click +Files (Figure 3‑24) to add additional attachments from the External Attachment Directory. If the External Attachment Directory has not been defined for this procedure, the last directory that was accessed may be displayed.   You can browse for other attachments to link to the study.  


Note: If the system parameter Allow Non-Instrument Attachments was not selected in CP Manager, +Files does not appear on the Clinical Procedures Study screen, you are not permitted to associate additional attachments with the procedure.


10. Submit the study. The images are copied to the RAID and the TIU document is created and associated with the procedure order.
  XE "study:submitting" 

 XE "submitting:studies" 
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Figure 3‑24
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Figure 3‑25
11. From Figure 3‑24, click the magnifying glass under TIU Note to view the TIU Note for that study if it is available. The magnifying glass for the TIU document is unavailable if the result has not been submitted to Vista imaging. Once the result is copied to VistA Imaging, you can view the TIU document of the study before or after the interpretation has been entered, Figure 3‑26.
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Figure 3‑26
12. From Figure 3‑24, you can also click the magnifying glass under Consult to view the Consult report for that study.
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Figure 3‑27
Updating Study XE "study:updating status"   XE "study:updating status" 

 XE "study:fixing errors" 

 XE "errors:updating" Status to Correct Errors

If you open a study in the Error status and have the MD MANAGER key, the Update Study Status window is displayed.  You must have the MD Manager key to access the Update Study Status menu option.  See your clinical application coordinator or IRM for access to Update Study Status.

You can use Update Study Status to change the status of any study.  Be careful when changing the status of a study.  With Update Study Status, you can force a status change of a study if a problem occurs that you cannot fix with the Open a Study option.

1. Select File > Update Study Status, Figure 3‑28.

2. Select the status you want to change and click OK.

3. After you change the status, choose File > Open a Study and click Submit to resubmit the study.
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Figure 3‑28
4. Clinical Procedures Process, Part 2 XE "CP process" 
This chapter describes the process to follow for completing clinical procedures.  (This chapter uses the example of completing a colonoscopy to describe the Clinical Procedures process.)  Be sure to follow the required steps in sequential order. You can do the optional steps as needed.

4. Complete the Procedure.  Required

a. Enter an Interpretation into the TIU note. Required

b. Enter Encounter information.  Required for workload counts

c. Sign off.  Required

5. View Clinical Procedures results.  Optional

6. Link consent forms and images to Clinical Procedures documents.  Optional

Completing the Procedure XE "study:completing" 
To complete the procedure, you need to enter the interpretation into the TIU note, enter encounter information, and sign off.  In this example, the colonoscopy study is being completed. 

Entering the interpretation into the TIU Note XE "interpretations:entering" 

 XE "TIU:entering interpretations" 
1. Logon to CPRS. The Patient Selection screen is displayed, Figure 4-1.
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Fig. 4-1

2. In the Notifications box at the bottom of the screen, patients are listed with “Procedure ready for interpretation”.  

- Click Process Info if you want to process an informational alert (see left column under Notifications, Fig. 4-1).
- Click Process All if you want to process all of the items listed.
- Click Process if you want to process an item through the Consults tab.
- Click Remove if you want to remove an item from the list.
- Click Forward if you want to forward the item to another person.

As part of this example, the patient, CPPATIENT, ONE, is selected.  To view results through Consults, click Process.  The Consults tab is displayed.
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Fig. 4-2

Note the image and note document within the Related Documents window (Fig. 4-2).

The consult procedure now has a status of partial results (pr).  The CP document has the TIU note title.

3. Click the CP title in the Related Documents window.  The CP document is displayed in the right window, Fig. 4-3.  
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Fig. 4-3

The Author is not defined, Figure 4-3.  This note is automatically created when the instrument result is sent and submitted and an author does not exist.  The Interpreter who is interpreting the result is the default Author.  The status of the document is always UNDICTATED when the results are ready for interpretation.

4. To select the results that you want to interpret, choose Action > Consult Results > Complete/Update Results, Figure 4-4. 
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Fig. 4-4

Note: To interpret the result, select the Complete/Update Results option.  The Enter Required Fields dialog box is displayed, Figure 4-5.  The interpreter’s name displays by default in the Author field.
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Fig. 4-5

5. Select the appropriate Procedure Summary Code from the list (Fig. 4-5).  The Procedure Summary Codes include Abnormal, Normal, Borderline, and Incomplete.

6. Enter a Procedure Date/Time.  Depending on the instrument, the Procedure Date/Time is passed in the HL7 message from the instrument.  As the interpreter, you can accept the default.  If the instrument does not pass the Procedure Date/Time, the interpreter has to enter a Procedure Date/Time.


The Procedure Summary Code and Procedure Date/Time are required fields for the initial note that you are editing.   

If you close the Enter Required Fields dialog box without entering the requested information, CPRS prompts the interpreter again. 

Any subsequent note created on the same procedure after this initial note does not require the Procedure Summary Code and Procedure Date/Time fields.  The fields are optional on subsequent notes.
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Fig 4-6

7. Enter an interpretation in the space on the right side of the screen for the highlighted (current) consult procedure (Fig. 4-6).

Entering Encounter Information XE "encounter information" 
You can now enter encounter form information.

8. To enter the encounter information and complete the consult procedure, you must select Action > Consult Results > Sign Note Now. 
You can also select the Encounter drawer (Fig. 4-6) to directly enter encounter information.
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Fig. 4-7

This window (Fig. 4-7) asks if you want to enter encounter information now.  (Fig. 4-7 is displayed depending on how CPRS parameters are set. See the Implementation Guide for information on defining CPRS parameters.)

9. Click Yes to enter encounter information, or click No to skip this step.  If you choose No, you can enter the information at a later time.  In this example, the Yes button is clicked and encounter information is entered.
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Fig. 4-8

Figure 4-8 allows you to verify the primary provider for this encounter form.

10. Click Yes.

CPRS brings up the Encounter Form that was set up for the Hospital Location, where the procedure was performed.  The Visit Type tab is displayed.


11. Enter appropriate information for visit type.  For example, in Figure 4-9, the following information was entered:

Type of Visit. Established Patient

Section Name. Intermediate Exam 11-19 Min.

Visit Related to Service Connected Condition. Yes

Current providers for this encounter. Gaddie, Marlie
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Fig. 4-9

12. Click the Diagnoses tab. 
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Fig. 4-10

13. Enter appropriate information for diagnoses.  See Figure 4-10.

14. Click the Procedures tab. 
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Fig. 4-11

15. Enter appropriate procedure information.  See Figure 4-11.

16. Click the Exams tab. 
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Fig. 4-12

17. Enter appropriate exam information.  (See Fig. 4-12.)  Click OK to return to the Consults tab.

Signing Off  XE "sign off" 
18. To complete the consult procedure, select Action > Consult Results > Sign Note Now. 
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Fig. 4-13

19. Enter your electronic signature to sign the TIU note and complete the consult procedure.  

20. Click OK.
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Fig. 4-14

· The consult procedure now has a status of complete (Fig. 4-14).

· The procedure location (GI LAB in Fig. 4-14) is used for workload reporting.

· The workload for the procedure goes through the standard TIU interface with PCE (Patient Care Encounter).

Even though the consult is complete, you can still attach additional files and studies to the same order. 

Viewing Clinical Procedures Results XE "imaging:display" 

 XE "CP results:viewing" 

 XE "viewing results" 

 XE "images:displaying" 
You can go to VistA Imaging to view results.  If you as the interpreter did not interpret the result right after the procedure was performed, you may want to view the results before you enter an interpretation.  In the colonoscopy example, the interpretation was entered in Fig. 4-6.  

1. Logon to CPRS.


2. Select Tools > VistA Imaging Display, Fig. 4-15.  The patient’s Abstract list is displayed, Fig. 4-16.
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Fig. 4-15
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Fig. 4-16

Note: VistA Imaging accepts procedure results in .bmp, jpg, jpeg, html, .pdf, .rft, tiff, and .txt formats.  

1. Select View > Clinical Procedures to view Clinical Procedures document titles.  The list of CP documents for the patient is displayed.  (Fig. 4-17).
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Fig. 4-17
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Fig. 4-18

2. Click a document title, and then click the camera icon to display the associated images for that CP document, Figure 4-18.
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Fig. 4-19

3. Double-click the abstract to open the result file, (Fig. 4-19)

4. In the screen where the CP documents are listed, Figure 4-18, click the CP title, and then click the report icon next to the camera.  The TIU Note is displayed, Fig. 4-20.
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Fig. 4-20

Fig. 4-20 is an example of a document that has been interpreted and signed.  

If you launch Imaging Display before the document is interpreted, the Author field is undefined and the status is UNDICTATED. Some users may want to view the results before interpreting. 
Linking Consent Forms XE "consent forms:linking"  and Images to CP Documents XE "imaging:capture" 
As the interpreter, you can link a consent form or other images to CP documents by using VistA Imaging Capture. VistA Imaging Capture software can capture clinical images or scanned documents and attach them to Clinical Procedures.  Refer to the VistA Imaging 3.0 MAG*3.0*7 Patch Document at the following website:

http://vaww.va.gov/imaging/3.0patches.htm
5. 
Viewing the Reports XE "Medicine/CP Reports" 
After installing the Medicine patch MC*2.3*39 and the Clinical Procedures (CP) patch MD*1.0*2, you can view the CP interpretations, which are TIU documents, along with Medicine reports on the Computerized Patient Record System (CPRS) Reports tab. 

Four changes are introduced with patches MC*2.3*39 and MD*1.0*2. 

· On the CPRS Reports tab the Medicine folder has been renamed Medicine/CP.  

· The CP procedure interpretations have been added to the list of Medicine procedures for viewing and displaying on the CPRS Reports tab.  

· Only completed and signed CP procedures are displayed for CP reports.  

· Unless you are a Subspecialty or a Manager key holder within the Medicine package, only released and verified Medicine procedures are displayed for Medicine reports.  However, if the View All field for a specific procedure in the Procedure/Subspecialty (#697.2) file is set to Yes, then all Medicine procedures of that type display.

· If you are a Subspecialty key holder within the Medicine package you can view all statuses of Medicine procedures for that subspecialty.

· If you are a Manager key holder within the Medicine package you can view all statuses of Medicine procedures.

· 
The Medicine View file (#690.2) controls which fields are displayed in the Medicine reports except for the Procedures (local only) report.  Because of the numerous background calculations in the PFT report, this report remains unchanged.  

· You can configure the Medicine Report to display in CPRS.  See Configuring the Medicine Report to Display in CPRS.

The difference between a Medicine Report and a CP Report is that all CP interpretations have a consult number associated with them.  The interpretation is the TIU document.  Medicine reports may have a consult procedure request number depending on whether the report was associated with a consult request or not.  Another difference is that the Medicine report displays the discrete data entered through the Medicine package.

You can print these reports by first viewing the report, opening the File menu and clicking Print.  Then select a Windows printer to print the report.

The Abnormal, Full Captioned, Full Report, Procedures (local only) and Procedures reports display a message at the end of each procedure, which indicates if there are images associated with that procedure.  The text is as follows:

NOTE: Images are associated with this procedure.

      Please use Imaging Display to view the images.

After installing MD*1.0*2, your Medicine/CP folder will look similar to the following.  (Click on a report to view the new format):

Clinical Reports

Medicine/CP

Abnormal
Brief Report
Full Captioned
Full Report
Procedures (local only)
Procedures
Some of these reports are also located under the Health Summary folder:

Health Summary

Adhoc Report

Medicine Abnormal Brief [MEDA]

Medicine Brief Report [MEDB]

Medicine Full Captioned [MEDC]

Medicine Full Report [MEDF]

Medicine Summary [MEDS] – This is a listing of procedure headings that fall within a specified date range.

The Procedures (local only) report can also be found under the list of Available Reports.

Abnormal XE "Medicine/CP Reports:Abnormal" 
This report shows all Medicine and CP interpretations that have a Procedure Summary Code of Abnormal.  The name of the report, selected date range and maximum number of occurrences (Max/site) appear above the report.

Medicine/CP Abnormal [From: May 4,2003 to May 3,2004] Max/site: 10

Printed for data from 05/04/2003 to 05/03/2004                 05/03/2004 13:16

***********************  CONFIDENTIAL  SUMMARY   pg. 1 ************************

CPPATIENT1, TEN    000-00-0110        3AS                       DOB: 02/03/1943

----------------------------- MEDA - Med Abnormal -----------------------------

-------------------------------------------------------------------------------

            COLONOSCOPY                     APR 16,2004@15:38   ABNORMAL

-------------------------------------------------------------------------------

APPOINTMENT DATE/TIME:   4/16/04@15:38

MEDICAL PATIENT:   CPPATIENT1, TEN
PROTOCOL:   STOMACH TEST

EGD SIMPLE PRIMARY EXAM:   Y

LAB OR XRAY:   LAB

OCCULT BLOOD:   

SPECIMEN COLLECTION:   

INDICATION COMMENT:   TESTING

LOCATION EVALUATED: 

  COLON ASCENDING

     GROSS: ABSENCE

     MEASUREMENT: 

     IMPRESSION: 

FELLOW:   

SUMMARY:   ABNORMAL

PRIMARY DIAGNOSIS:   

PROCEDURE SUMMARY:   TESTING THE PROCEDURE

INSTRUMENT: 

  SCOPE 1

ENDOSCOPIST:   CPPROVIDER1, SEVEN
WHERE PERFORMED:   

WARD/CLINIC:   GI LAB

TIME STARTED:   0600

TIME COMPLETED:   1000

URGENCY OF PROCEDURE:   ELECTIVE

PREPARATION DIET:   CLEAR LIQUIDS

DIET COMMENT:   

ENEMAS:   PHOSPHASODA

COMMON BILE DUCT SIZE (mm):   

PANCREATIC DUCT SIZE (mm):   

DEPTH OF INSERTION:   

POST-PROC INSTRUMENT CLEANSING:   

SECOND FELLOW:   

INSTRUCTIONS TO PATIENT: 

-------------------------------------------------------------------------------

            PULMONARY FUNCTION TEST         MAR 16,2004@13:40   ABNORMAL

-------------------------------------------------------------------------------

SEX: M  AGE: 61          90 in/160 lb                       AMBIENT: 35C/600T

RACE: WHITE, NOT OF HISPANIC ORIGIN                         TECH: CPUSER, TEN
SMOKER                        CURRENT BRONCHODILATOR USE    EFFORT: GOOD

CONSULT DX: 

               COUGH

               ASTHMA

               INTERSTITIAL LUNG DISEASE

................................................................................

               UNITS     PRED      ACTUAL     %PRED    PREV1     PREV2   CI

VOLUMES.........................................................................

     INERT GAS DILUTION                                6/30/03   6/6/02

(NOTES): TEST INERT GAS

     TLC          L      10.53      9.00      85.5      5.00      8.00     9.09

     VC           L       7.76      3.00      38.7      7.00      7.00

     FRC          L       4.38      4.00      91.4      3.00      6.50  U  5.42

     RV           L       2.80      5.00     178.3      4.00      4.00  U  3.68

     RV/TLC       %                   56

     BODY BOX                                          6/30/03   6/6/02

(NOTES): TEST BODY BOX

     TLC          L      10.53      3.00      28.5      7.00      9.90     9.09

     VC           L       7.76      2.00      25.8      6.00      7.00

     FRC          L       4.38      4.00      91.4      4.00      6.00  U  5.42

     RV           L       2.80      5.00     178.3      2.00      5.00  U  3.68

     RV/TLC       %                  167

     NITROGEN WASH OUT                                 6/6/02    5/31/02

(NOTES): TEST NITROGEN WASH OUT

     TLC          L      10.53      7.00      66.5      6.00      7.00     9.09

     VC           L       7.76      4.00      51.5      5.50      6.00

     FRC          L       4.38      3.00      68.6      4.00      4.00  U  5.42

     RV           L       2.80      2.00      71.3      3.00      3.00  U  3.68

     RV/TLC       %                   29

     X-RAY PLANIMETRY                                  6/6/02    5/30/02

(NOTES): TEST X-RAY

     TLC          L      10.53      5.00      47.5      7.00      9.00     9.09

     VC           L       7.76      4.00      51.5      6.40      6.00

     FRC          L       4.38      7.00     160.0      3.00      4.00  U  5.42

     RV           L       2.80      8.00     285.2      1.00      5.00  U  3.68

     RV/TLC       %                  160

               UNITS     PRED      ACTUAL     %PRED    PREV1     PREV2   CI

FLOWS...........................................................................

MACHINE: FLOW TURBINE

    STANDARD STUDY                                     6/6/02    5/30/02

    (NOTES): TEST STANDARD

     FVC       L          7.76      4.30      55.4      8.00      9.00

     FEV1      L          5.79      2.20      38.0      6.00      4.00    4.94

     PF        L/SEC     10.986     3.200     29.1      5.000     5.000   8.02

     FEF25-75  L/SEC      4.478     4.500    100.5      4.000    15.000   2.81

     MVV       L/MIN     211.72     3.00       1.4      4.00     10.00  163.87

     FEV1/FVC    %                    51

    AFTER INHALATION CHALLENGE                         6/6/02    5/31/02

    (NOTES): AFTER INHALATION

     FVC       L          7.76      7.00      90.2      8.00      9.00

     FEV1      L          5.79      4.00      69.1      7.00      8.00    4.94

     PF        L/SEC     10.986     3.000     27.3      6.000     7.000   8.02

     FEF25-75  L/SEC      4.478     5.000    111.6      5.000    10.000   2.81

     MVV       L/MIN     211.72     3.00       1.4      4.00     50.00  163.87

     FEV1/FVC    %                    57

    AFTER EXERCISE                                     6/6/02    5/31/02

     FVC       L          7.76      5.00      64.4      8.00      9.90

     FEV1      L          5.79      3.00      51.9      7.00      8.00    4.94

     PF        L/SEC     10.986     2.000     18.2      6.000     7.000   8.02

     FEV1/FVC    %                    60

DIFFUSION.......................................................................

  METHOD: STEADY STATE

                                                       6/30/03   6/6/02

     DLCO-SB   L         37.16     33.00      88.8     45.00     50.00   29.18

Corr DLCO for HB & COHB: 37.16     32.55      87.6

BLOOD GASES.....................................................................

STUDY TYPE      pH    pCO2  pO2     O2HB   COHB MHB    HB   FiO2 A-aO2  QS/QT

  (NORMAL)  7.36-7.44 36-44 80-100 >88%    <3%  <2%              <22

100% O2 STUDY  7.000   0.0   0.0    4.0%   0.0% 0.0%   3.0 0.500  277 

PATIENT TEMPERATURE (C): 35

MAX EXERCISE   8.000  44.0   3.0   53.0%  33.0%23.0%  15.4 0.343  132 

PATIENT TEMPERATURE (C): 30

(NOTES): TEST QS

SUPPLEMENTAL   8.000   9.0   0.0   67.0%   0.0%56.0%   0.0 0.900  486 

PATIENT TEMPERATURE (C): 32

POST EXERCISE  7.456  99.0 345.0   78.0%  45.0%45.0%  15.1 1.000   84   0.52

PATIENT TEMPERATURE (C): 33

(NOTES): TEST QS

               UNITS               ACTUAL              PREV1     PREV2

SPECIAL STUDIES.................................................................

     MAXIMUM PRESSURES                                 6/30/03   6/6/02

    (NOTES): 44

     PiMAX        cmH2O             5.00               99.00     68.00

     MECHANICS                                         6/30/03   6/6/02

     Raw          cmH20/L/S         4.00               15.00     10.00

     SGaw         L/S/cmH20         0.30                0.30      0.20

     Cst          4cmH20            0.50                1.00      0.40

     SMALL AIRWAY                                      6/30/03   6/6/02

     Cdyn         L/cmH20           0.40                1.00      0.45

     FEF50 He-Air L/Sec            45.00               45.00     56.00

     VISOV        L                 3.00                5.00      5.00

     CV           L                 5.00                4.00      5.00

     CV/VC        %                 2.50     

     CV/TLC       %                 1.67

     VISOV/CV     %                 0.60

     EXERCISE                                          6/30/03   6/6/02

    (NOTES): Insert note here
     VEmax(BTPS)  L                44.00               90.00     90.00

     BR           L                34.00               50.00     50.00

     VD/VT MAX    L                 0.70                          0.43

     VErest(BTPS) ml/beat           3.00               35.00     30.00

     EKG                           ABNORMAL

     Wmax         wrpm/min          2.00               100.00    245.00

     WRI/WRT      watts/min         3.00               35.00     40.00

     Max Speed    mph              15.00               20.00     15.00

     TOTAL TIME   min              100.00              100.00    600.00

Exercise Testing Mode: BIKE ERGOMETER

REASON(S) FOR STOPPING:

                           Patient cannot work on Bike Treadmill anymore. 

                           he will work on something different such as a

                           Cardioglider.

INTERPRETATION:

COMMENTS AND RECOMMENDATIONS:

INTERPRETED BY: 

                SMITH,JOE

                        PREDICTED VALUE FORMULAS USED

    TLC              .078*HT-7.3                  BOREN & KORY '66

    VC               .06*HT-(.0214*AGE)-4.65      CRAPO '81

    FRC              .032*HT-2.94                 BOREN & KOREY '66

    RV               .019*HT+(.0115*AGE)-2.24     BOREN & KORY '66

    FVC              .06*HT-(.0214*AGE)-4.65      CRAPO '81

    FEV1             .0414*HT-(.0244*AGE)-2.190   CRAPO '81

    PF               3.9*HT-(3*AGE)-49.36/60      FERRIS '64

    FEF25-75         .0204*HT-(.038*AGE)+2.133    CRAPO '81

    MVV              1.356*HT-(1.26*AGE)-21.4     BOREN & KOREY '66

    DLCO-SB          12.9113-(.229*AGE)+(.1672*HT) MILLER '83

    COHB CORR.       ACT*(1+(COHB/100))           MORRIS '85

    HB CORR.         HB+10.22/(1.7*HB)*ACT        COTES '72

NOTE:  HT=height,WT=weight,ACT=actual measurement value

*** END ***************  CONFIDENTIAL  SUMMARY   pg. 1 ***********************

Brief Report XE "Medicine/CP Reports:Brief Report" 
This report lists all procedures (Medicine and CP) that fall within a specified date range and the maximum number of occurrences (Max/site).  The name of the report, selected date range and maximum number of occurrences (Max/site) appear above the report.  These procedures are listed according to Consult Number, Completed Procedures, Date/Time Performed and Procedure Code (also known as Procedure Summary Code).

Medicine/CP Brief Report [From: May 4,2003 to May 3,2004] Max/site: 10
Printed for data from 05/04/2003 to 05/03/2004                 05/03/2004 13:22

***********************  CONFIDENTIAL  SUMMARY   pg. 1 ************************

CPPATIENT1, TEN    000-00-0110        3AS                       DOB: 02/03/1943

--------------------------- MEDB - Med Brief Report ---------------------------

  CONSULT                                   DATE/TIME

   NUMBER   COMPLETED PROCEDURES            PERFORMED              PROCEDURE CODE

  -------   ------------------------------  ----------------       -----------------

            COLONOSCOPY                     APR 16,2004@15:38      ABNORMAL

            PULMONARY FUNCTION TEST         MAR 30,2004@13:43      

            PULMONARY FUNCTION TEST         MAR 16,2004@13:40      ABNORMAL

            ELECTROPHYSIOLOGY               JUN 30,2003@10:40      ABNORMAL

            PULMONARY FUNCTION TEST         JUN 30,2003@09:37      NORMAL

*** END ***************  CONFIDENTIAL  SUMMARY   pg. 1 ***********************

Full Captioned XE "Medicine/CP Reports:Full Captioned" 
This report shows all Medicine and CP reports within a specified date range and the maximum number of occurrences (Max/site).  The name of the report, selected date range and maximum number of occurrences (Max/site) appear above the report.   Fields that do not contain data within the Medicine reports do not display.

Medicine/CP Full Captioned [From: May 20,2003 to May 19,2004] Max/site: 10
Printed for data from 05/20/2003 to 05/19/2004                 05/19/2004 14:54

***********************  CONFIDENTIAL  SUMMARY   pg. 1 ************************

CPPATIENT1, TEN    000-00-0110        3AS                       DOB: 02/03/1943

-------------------------- MEDC - Med Full Captioned --------------------------

-------------------------------------------------------------------------------

            COLONOSCOPY                     APR 16,2004@15:38   ABNORMAL

-------------------------------------------------------------------------------

APPOINTMENT DATE/TIME:   4/16/04@15:38

MEDICAL PATIENT:   CPPATIENT1, TEN
PROTOCOL:   STOMACH TEST

EGD SIMPLE PRIMARY EXAM:   Y

LAB OR XRAY:   LAB

INDICATION COMMENT:   TESTING

LOCATION EVALUATED: 

  COLON ASCENDING

     GROSS: ABSENCE

SUMMARY:   ABNORMAL

PROCEDURE SUMMARY:   TESTING THE PROCEDURE

INSTRUMENT: 

  SCOPE 1

ENDOSCOPIST:   CPPROVIDER1, SEVEN
WARD/CLINIC:   GI LAB

TIME STARTED:   0600

TIME COMPLETED:   1000

URGENCY OF PROCEDURE:   ELECTIVE

PREPARATION DIET:   CLEAR LIQUIDS

ENEMAS:   PHOSPHASODA

-------------------------------------------------------------------------------

            PULMONARY FUNCTION TEST         MAR 30,2004@13:43   

-------------------------------------------------------------------------------

SEX: M  AGE: 61          85 in/167 lb                       AMBIENT: 35C/600T

RACE: WHITE, NOT OF HISPANIC ORIGIN                         TECH: CPUSER, TEN
NON-SMOKER                    CURRENT BRONCHODILATOR USE    EFFORT: GOOD

CONSULT DX: 

               COUGH

................................................................................

               UNITS     PRED      ACTUAL     %PRED    PREV1     PREV2   CI

VOLUMES.........................................................................

     BODY BOX                                          3/16/04   6/30/03

     TLC          L       9.54      2.00      21.0      3.00      7.00     8.10

     VC           L       7.00      3.00      42.9      2.00      6.00

     FRC          L       3.97      4.00     100.8      4.00      4.00  U  5.01

     RV           L       2.56      5.00     195.0      5.00      2.00  U  3.44

     RV/TLC       %                  250

INTERPRETATION:

COMMENTS AND RECOMMENDATIONS:

INTERPRETED BY: 

                        PREDICTED VALUE FORMULAS USED

    TLC              .078*HT-7.3                  BOREN & KORY '66

    VC               .06*HT-(.0214*AGE)-4.65      CRAPO '81

    FRC              .032*HT-2.94                 BOREN & KOREY '66

    RV               .019*HT+(.0115*AGE)-2.24     BOREN & KORY '66

    FVC              .06*HT-(.0214*AGE)-4.65      CRAPO '81

    FEV1             .0414*HT-(.0244*AGE)-2.190   CRAPO '81

    PF               3.9*HT-(3*AGE)-49.36/60      FERRIS '64

    FEF25-75         .0204*HT-(.038*AGE)+2.133    CRAPO '81

    MVV              1.356*HT-(1.26*AGE)-21.4     BOREN & KOREY '66

    DLCO-SB          12.9113-(.229*AGE)+(.1672*HT) MILLER '83

    COHB CORR.       ACT*(1+(COHB/100))           MORRIS '85

    HB CORR.         HB+10.22/(1.7*HB)*ACT        COTES '72

NOTE:  HT=height,WT=weight,ACT=actual measurement value

-------------------------------------------------------------------------------

            PULMONARY FUNCTION TEST         MAR 16,2004@13:40   ABNORMAL

-------------------------------------------------------------------------------

SEX: M  AGE: 61          90 in/160 lb                       AMBIENT: 35C/600T

RACE: WHITE, NOT OF HISPANIC ORIGIN                         TECH: CPUSER, TEN
SMOKER                        CURRENT BRONCHODILATOR USE    EFFORT: GOOD

CONSULT DX: 

               COUGH

               ASTHMA

               INTERSTITIAL LUNG DISEASE

................................................................................

               UNITS     PRED      ACTUAL     %PRED    PREV1     PREV2   CI

VOLUMES.........................................................................

     INERT GAS DILUTION                                6/30/03   6/6/02

(NOTES): TEST INERT GAS

     TLC          L      10.53      9.00      85.5      5.00      8.00     9.09

     VC           L       7.76      3.00      38.7      7.00      7.00

     FRC          L       4.38      4.00      91.4      3.00      6.50  U  5.42

     RV           L       2.80      5.00     178.3      4.00      4.00  U  3.68

     RV/TLC       %                   56

     BODY BOX                                          6/30/03   6/6/02

(NOTES): TEST BODY BOX

     TLC          L      10.53      3.00      28.5      7.00      9.90     9.09

     VC           L       7.76      2.00      25.8      6.00      7.00

     FRC          L       4.38      4.00      91.4      4.00      6.00  U  5.42

     RV           L       2.80      5.00     178.3      2.00      5.00  U  3.68

     RV/TLC       %                  167

     NITROGEN WASH OUT                                 6/6/02    5/31/02

(NOTES): TEST NITROGEN WASH OUT

     TLC          L      10.53      7.00      66.5      6.00      7.00     9.09

     VC           L       7.76      4.00      51.5      5.50      6.00

     FRC          L       4.38      3.00      68.6      4.00      4.00  U  5.42

     RV           L       2.80      2.00      71.3      3.00      3.00  U  3.68

     RV/TLC       %                   29

     X-RAY PLANIMETRY                                  6/6/02    5/30/02

(NOTES): TEST X-RAY

     TLC          L      10.53      5.00      47.5      7.00      9.00     9.09

     VC           L       7.76      4.00      51.5      6.40      6.00

     FRC          L       4.38      7.00     160.0      3.00      4.00  U  5.42

     RV           L       2.80      8.00     285.2      1.00      5.00  U  3.68

     RV/TLC       %                  160

               UNITS     PRED      ACTUAL     %PRED    PREV1     PREV2   CI

FLOWS...........................................................................

MACHINE: FLOW TURBINE

    STANDARD STUDY                                     6/6/02    5/30/02

    (NOTES): TEST STANDARD

     FVC       L          7.76      4.30      55.4      8.00      9.00

     FEV1      L          5.79      2.20      38.0      6.00      4.00    4.94

     PF        L/SEC     10.986     3.200     29.1      5.000     5.000   8.02

     FEF25-75  L/SEC      4.478     4.500    100.5      4.000    15.000   2.81

     MVV       L/MIN     211.72     3.00       1.4      4.00     10.00  163.87

     FEV1/FVC    %                    51

    AFTER INHALATION CHALLENGE                         6/6/02    5/31/02

    (NOTES): AFTER INHALATION

     FVC       L          7.76      7.00      90.2      8.00      9.00

     FEV1      L          5.79      4.00      69.1      7.00      8.00    4.94

     PF        L/SEC     10.986     3.000     27.3      6.000     7.000   8.02

     FEF25-75  L/SEC      4.478     5.000    111.6      5.000    10.000   2.81

     MVV       L/MIN     211.72     3.00       1.4      4.00     50.00  163.87

     FEV1/FVC    %                    57

    AFTER EXERCISE                                     6/6/02    5/31/02

     FVC       L          7.76      5.00      64.4      8.00      9.90

     FEV1      L          5.79      3.00      51.9      7.00      8.00    4.94

     PF        L/SEC     10.986     2.000     18.2      6.000     7.000   8.02

     FEV1/FVC    %                    60

DIFFUSION.......................................................................

  METHOD: STEADY STATE

                                                       6/30/03   6/6/02

     DLCO-SB   L         37.16     33.00      88.8     45.00     50.00   29.18

Corr DLCO for HB & COHB: 37.16     32.55      87.6

BLOOD GASES.....................................................................

STUDY TYPE      pH    pCO2  pO2     O2HB   COHB MHB    HB   FiO2 A-aO2  QS/QT

  (NORMAL)  7.36-7.44 36-44 80-100 >88%    <3%  <2%              <22

100% O2 STUDY  7.000   0.0   0.0    4.0%   0.0% 0.0%   3.0 0.500  277 

PATIENT TEMPERATURE (C): 35

MAX EXERCISE   8.000  44.0   3.0   53.0%  33.0%23.0%  15.4 0.343  132 

PATIENT TEMPERATURE (C): 30

(NOTES): TEST QS

SUPPLEMENTAL   8.000   9.0   0.0   67.0%   0.0%56.0%   0.0 0.900  486 

PATIENT TEMPERATURE (C): 32

POST EXERCISE  7.456  99.0 345.0   78.0%  45.0%45.0%  15.1 1.000   84   0.52

PATIENT TEMPERATURE (C): 33

(NOTES): TEST QS

               UNITS               ACTUAL              PREV1     PREV2

SPECIAL STUDIES.................................................................

     MAXIMUM PRESSURES                                 6/30/03   6/6/02

    (NOTES): 44

     PiMAX        cmH2O             5.00               99.00     68.00

     MECHANICS                                         6/30/03   6/6/02

     Raw          cmH20/L/S         4.00               15.00     10.00

     SGaw         L/S/cmH20         0.30                0.30      0.20

     Cst          4cmH20            0.50                1.00      0.40

     SMALL AIRWAY                                      6/30/03   6/6/02

     Cdyn         L/cmH20           0.40                1.00      0.45

     FEF50 He-Air L/Sec            45.00               45.00     56.00

     VISOV        L                 3.00                5.00      5.00

     CV           L                 5.00                4.00      5.00

     CV/VC        %                 2.50     

     CV/TLC       %                 1.67

     VISOV/CV     %                 0.60

     EXERCISE                                          6/30/03   6/6/02

    (NOTES): Insert note here
     VEmax(BTPS)  L                44.00               90.00     90.00

     BR           L                34.00               50.00     50.00

     VD/VT MAX    L                 0.70                          0.43

     VErest(BTPS) ml/beat           3.00               35.00     30.00

     EKG                           ABNORMAL

     Wmax         wrpm/min          2.00               100.00    245.00

     WRI/WRT      watts/min         3.00               35.00     40.00

     Max Speed    mph              15.00               20.00     15.00

     TOTAL TIME   min              100.00              100.00    600.00

Exercise Testing Mode: BIKE ERGOMETER

REASON(S) FOR STOPPING:

                           Patient cannot work on Bike Treadmill anymore. 

                           he will work on something different such as a

                           Cardioglider.

INTERPRETATION:

COMMENTS AND RECOMMENDATIONS:

INTERPRETED BY: 

                CPUSER, TEN
                        PREDICTED VALUE FORMULAS USED

    TLC              .078*HT-7.3                  BOREN & KORY '66

    VC               .06*HT-(.0214*AGE)-4.65      CRAPO '81

    FRC              .032*HT-2.94                 BOREN & KOREY '66

    RV               .019*HT+(.0115*AGE)-2.24     BOREN & KORY '66

    FVC              .06*HT-(.0214*AGE)-4.65      CRAPO '81

    FEV1             .0414*HT-(.0244*AGE)-2.190   CRAPO '81

    PF               3.9*HT-(3*AGE)-49.36/60      FERRIS '64

    FEF25-75         .0204*HT-(.038*AGE)+2.133    CRAPO '81

    MVV              1.356*HT-(1.26*AGE)-21.4     BOREN & KOREY '66

    DLCO-SB          12.9113-(.229*AGE)+(.1672*HT) MILLER '83

    COHB CORR.       ACT*(1+(COHB/100))           MORRIS '85

    HB CORR.         HB+10.22/(1.7*HB)*ACT        COTES '72

NOTE:  HT=height,WT=weight,ACT=actual measurement value

*** END ***************  CONFIDENTIAL  SUMMARY   pg. 1 ***********************

Full Report XE "Medicine/CP Reports:Full Report" 
This report shows all Medicine and CP reports within a specified date range and the maximum number of occurrences (Max/site).  The name of the report, selected date range and maximum number of occurrences (Max/site) appear above the report.  All data fields, including null values, are displayed.

Medicine/CP Full Report [From: May 20,2003 to May 19,2004] Max/site: 10
Printed for data from 05/20/2003 to 05/19/2004                 05/19/2004 13:25

***********************  CONFIDENTIAL  SUMMARY   pg. 1 ************************

CPPATIENT1, TEN    000-00-0110        3AS                       DOB: 02/03/1943

--------------------------- MEDF - Med Full Report ---------------------------

-------------------------------------------------------------------------------

            COLONOSCOPY                     APR 16,2004@15:38   ABNORMAL

-------------------------------------------------------------------------------

APPOINTMENT DATE/TIME:   4/16/04@15:38

MEDICAL PATIENT:   CPPATIENT1, TEN
PROTOCOL:   STOMACH TEST

EGD SIMPLE PRIMARY EXAM:   Y

LAB OR XRAY:   LAB

OCCULT BLOOD:   

SPECIMEN COLLECTION:   

INDICATION COMMENT:   TESTING

LOCATION EVALUATED: 

  COLON ASCENDING

     GROSS: ABSENCE

     MEASUREMENT: 

     IMPRESSION: 

FELLOW:   

SUMMARY:   ABNORMAL

PRIMARY DIAGNOSIS:   

PROCEDURE SUMMARY:   TESTING THE PROCEDURE

INSTRUMENT: 

  SCOPE 1

ENDOSCOPIST:   CPPROVIDER1, SEVEN
WHERE PERFORMED:   

WARD/CLINIC:   GI LAB

TIME STARTED:   0600

TIME COMPLETED:   1000

URGENCY OF PROCEDURE:   ELECTIVE

PREPARATION DIET:   CLEAR LIQUIDS

DIET COMMENT:   

ENEMAS:   PHOSPHASODA

COMMON BILE DUCT SIZE (mm):   

PANCREATIC DUCT SIZE (mm):   

DEPTH OF INSERTION:   

POST-PROC INSTRUMENT CLEANSING:   

SECOND FELLOW:   

INSTRUCTIONS TO PATIENT: 

-------------------------------------------------------------------------------

            PULMONARY FUNCTION TEST         MAR 30,2004@13:43   

-------------------------------------------------------------------------------

SEX: M  AGE: 61          85 in/167 lb                       AMBIENT: 35C/600T

RACE: WHITE, NOT OF HISPANIC ORIGIN                         TECH: CPUSER1, ONE
NON-SMOKER                    CURRENT BRONCHODILATOR USE    EFFORT: GOOD

CONSULT DX: 

               COUGH

................................................................................

               UNITS     PRED      ACTUAL     %PRED    PREV1     PREV2   CI

VOLUMES.........................................................................

     BODY BOX                                          3/16/04   6/30/03

     TLC          L       9.54      2.00      21.0      3.00      7.00     8.10

     VC           L       7.00      3.00      42.9      2.00      6.00

     FRC          L       3.97      4.00     100.8      4.00      4.00  U  5.01

     RV           L       2.56      5.00     195.0      5.00      2.00  U  3.44

     RV/TLC       %                  250

INTERPRETATION:

COMMENTS AND RECOMMENDATIONS:

INTERPRETED BY: 

                        PREDICTED VALUE FORMULAS USED

    TLC              .078*HT-7.3                  BOREN & KORY '66

    VC               .06*HT-(.0214*AGE)-4.65      CRAPO '81

    FRC              .032*HT-2.94                 BOREN & KOREY '66

    RV               .019*HT+(.0115*AGE)-2.24     BOREN & KORY '66

    FVC              .06*HT-(.0214*AGE)-4.65      CRAPO '81

    FEV1             .0414*HT-(.0244*AGE)-2.190   CRAPO '81

    PF               3.9*HT-(3*AGE)-49.36/60      FERRIS '64

    FEF25-75         .0204*HT-(.038*AGE)+2.133    CRAPO '81

    MVV              1.356*HT-(1.26*AGE)-21.4     BOREN & KOREY '66

    DLCO-SB          12.9113-(.229*AGE)+(.1672*HT) MILLER '83

    COHB CORR.       ACT*(1+(COHB/100))           MORRIS '85

    HB CORR.         HB+10.22/(1.7*HB)*ACT        COTES '72

NOTE:  HT=height,WT=weight,ACT=actual measurement value

-------------------------------------------------------------------------------

            PULMONARY FUNCTION TEST         MAR 16,2004@13:40   ABNORMAL

-------------------------------------------------------------------------------

SEX: M  AGE: 61          90 in/160 lb                       AMBIENT: 35C/600T

RACE: WHITE, NOT OF HISPANIC ORIGIN                         TECH: CPUSER, TEN
SMOKER                        CURRENT BRONCHODILATOR USE    EFFORT: GOOD

CONSULT DX: 

               COUGH

               ASTHMA

               INTERSTITIAL LUNG DISEASE

................................................................................

               UNITS     PRED      ACTUAL     %PRED    PREV1     PREV2   CI

VOLUMES.........................................................................

     INERT GAS DILUTION                                6/30/03   6/6/02

(NOTES): TEST INERT GAS

     TLC          L      10.53      9.00      85.5      5.00      8.00     9.09

     VC           L       7.76      3.00      38.7      7.00      7.00

     FRC          L       4.38      4.00      91.4      3.00      6.50  U  5.42

     RV           L       2.80      5.00     178.3      4.00      4.00  U  3.68

     RV/TLC       %                   56

     BODY BOX                                          6/30/03   6/6/02

(NOTES): TEST BODY BOX

     TLC          L      10.53      3.00      28.5      7.00      9.90     9.09

     VC           L       7.76      2.00      25.8      6.00      7.00

     FRC          L       4.38      4.00      91.4      4.00      6.00  U  5.42

     RV           L       2.80      5.00     178.3      2.00      5.00  U  3.68

     RV/TLC       %                  167

     NITROGEN WASH OUT                                 6/6/02    5/31/02

(NOTES): TEST NITROGEN WASH OUT

     TLC          L      10.53      7.00      66.5      6.00      7.00     9.09

     VC           L       7.76      4.00      51.5      5.50      6.00

     FRC          L       4.38      3.00      68.6      4.00      4.00  U  5.42

     RV           L       2.80      2.00      71.3      3.00      3.00  U  3.68

     RV/TLC       %                   29

     X-RAY PLANIMETRY                                  6/6/02    5/30/02

(NOTES): TEST X-RAY

     TLC          L      10.53      5.00      47.5      7.00      9.00     9.09

     VC           L       7.76      4.00      51.5      6.40      6.00

     FRC          L       4.38      7.00     160.0      3.00      4.00  U  5.42

     RV           L       2.80      8.00     285.2      1.00      5.00  U  3.68

     RV/TLC       %                  160

               UNITS     PRED      ACTUAL     %PRED    PREV1     PREV2   CI

FLOWS...........................................................................

MACHINE: FLOW TURBINE

    STANDARD STUDY                                     6/6/02    5/30/02

    (NOTES): TEST STANDARD

     FVC       L          7.76      4.30      55.4      8.00      9.00

     FEV1      L          5.79      2.20      38.0      6.00      4.00    4.94

     PF        L/SEC     10.986     3.200     29.1      5.000     5.000   8.02

     FEF25-75  L/SEC      4.478     4.500    100.5      4.000    15.000   2.81

     MVV       L/MIN     211.72     3.00       1.4      4.00     10.00  163.87

     FEV1/FVC    %                    51

    AFTER INHALATION CHALLENGE                         6/6/02    5/31/02

    (NOTES): AFTER INHALATION

     FVC       L          7.76      7.00      90.2      8.00      9.00

     FEV1      L          5.79      4.00      69.1      7.00      8.00    4.94

     PF        L/SEC     10.986     3.000     27.3      6.000     7.000   8.02

     FEF25-75  L/SEC      4.478     5.000    111.6      5.000    10.000   2.81

     MVV       L/MIN     211.72     3.00       1.4      4.00     50.00  163.87

     FEV1/FVC    %                    57

    AFTER EXERCISE                                     6/6/02    5/31/02

     FVC       L          7.76      5.00      64.4      8.00      9.90

     FEV1      L          5.79      3.00      51.9      7.00      8.00    4.94

     PF        L/SEC     10.986     2.000     18.2      6.000     7.000   8.02

     FEV1/FVC    %                    60

DIFFUSION.......................................................................

  METHOD: STEADY STATE

                                                       6/30/03   6/6/02

     DLCO-SB   L         37.16     33.00      88.8     45.00     50.00   29.18

Corr DLCO for HB & COHB: 37.16     32.55      87.6

BLOOD GASES.....................................................................

STUDY TYPE      pH    pCO2  pO2     O2HB   COHB MHB    HB   FiO2 A-aO2  QS/QT

  (NORMAL)  7.36-7.44 36-44 80-100 >88%    <3%  <2%              <22

100% O2 STUDY  7.000   0.0   0.0    4.0%   0.0% 0.0%   3.0 0.500  277 

PATIENT TEMPERATURE (C): 35

MAX EXERCISE   8.000  44.0   3.0   53.0%  33.0%23.0%  15.4 0.343  132 

PATIENT TEMPERATURE (C): 30

(NOTES): TEST QS

SUPPLEMENTAL   8.000   9.0   0.0   67.0%   0.0%56.0%   0.0 0.900  486 

PATIENT TEMPERATURE (C): 32

POST EXERCISE  7.456  99.0 345.0   78.0%  45.0%45.0%  15.1 1.000   84   0.52

PATIENT TEMPERATURE (C): 33

(NOTES): TEST QS

               UNITS               ACTUAL              PREV1     PREV2

SPECIAL STUDIES.................................................................

     MAXIMUM PRESSURES                                 6/30/03   6/6/02

    (NOTES): 44

     PiMAX        cmH2O             5.00               99.00     68.00

     MECHANICS                                         6/30/03   6/6/02

     Raw          cmH20/L/S         4.00               15.00     10.00

     SGaw         L/S/cmH20         0.30                0.30      0.20

     Cst          4cmH20            0.50                1.00      0.40

     SMALL AIRWAY                                      6/30/03   6/6/02

     Cdyn         L/cmH20           0.40                1.00      0.45

     FEF50 He-Air L/Sec            45.00               45.00     56.00

     VISOV        L                 3.00                5.00      5.00

     CV           L                 5.00                4.00      5.00

     CV/VC        %                 2.50     

     CV/TLC       %                 1.67

     VISOV/CV     %                 0.60

     EXERCISE                                          6/30/03   6/6/02

    (NOTES): Insert note here
     VEmax(BTPS)  L                44.00               90.00     90.00

     BR           L                34.00               50.00     50.00

     VD/VT MAX    L                 0.70                          0.43

     VErest(BTPS) ml/beat           3.00               35.00     30.00

     EKG                           ABNORMAL

     Wmax         wrpm/min          2.00               100.00    245.00

     WRI/WRT      watts/min         3.00               35.00     40.00

     Max Speed    mph              15.00               20.00     15.00

     TOTAL TIME   min              100.00              100.00    600.00

Exercise Testing Mode: BIKE ERGOMETER

REASON(S) FOR STOPPING:

                           Patient cannot work on Bike Treadmill anymore. 

                           he will work on something different such as a

                           Cardioglider.

INTERPRETATION:

COMMENTS AND RECOMMENDATIONS:

INTERPRETED BY: 

                CPUSER, TEN
                        PREDICTED VALUE FORMULAS USED

    TLC              .078*HT-7.3                  BOREN & KORY '66

    VC               .06*HT-(.0214*AGE)-4.65      CRAPO '81

    FRC              .032*HT-2.94                 BOREN & KOREY '66

    RV               .019*HT+(.0115*AGE)-2.24     BOREN & KORY '66

    FVC              .06*HT-(.0214*AGE)-4.65      CRAPO '81

    FEV1             .0414*HT-(.0244*AGE)-2.190   CRAPO '81

    PF               3.9*HT-(3*AGE)-49.36/60      FERRIS '64

    FEF25-75         .0204*HT-(.038*AGE)+2.133    CRAPO '81

    MVV              1.356*HT-(1.26*AGE)-21.4     BOREN & KOREY '66

    DLCO-SB          12.9113-(.229*AGE)+(.1672*HT) MILLER '83

    COHB CORR.       ACT*(1+(COHB/100))           MORRIS '85

    HB CORR.         HB+10.22/(1.7*HB)*ACT        COTES '72

NOTE:  HT=height,WT=weight,ACT=actual measurement value

*** END ***************  CONFIDENTIAL  SUMMARY   pg. 1 ***********************

Procedures (local only) XE "Medicine/CP Reports:Procedures (local only)" 
This report component lists all Medicine and CP procedures for a selected patient in CPRS.  The Procedures (local only) list contains the following column elements: Procedure Date/Time, Medicine Procedure Name, and Report Status (also known as the Procedure Summary Code). 
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The Procedure Date/Time column lists the procedures in chronological order.  Both the Medicine and CP procedures are listed together.  After you select the procedure that you want to view, the report is displayed in the lower-right portion of your screen.  If you see an interpretation (TIU document), then you are viewing a CP procedure, otherwise you are viewing a Medicine procedure.

Here is an example of a CP Report.

Pg. 1                         HINES VAMC

                         SPIROMETRY, PRE and POST

CPPATIENT1, TEN    000-00-0110                     DOB: FEB 3,1943  (61) 3AS 

-------------------------------------------------------------------------------

--------------------------------------------------------------------------------

       TITLE: HISTORICAL PROCEDURE REPORT                              

DATE OF NOTE: JUL 03, 2003@13:46     ENTRY DATE: JUL 03, 2003@13:46:22      

      AUTHOR: CPUSER1, ONE           EXP COSIGNER:                           

     URGENCY:                            STATUS: COMPLETED                     

PROCEDURE SUMMARY CODE: Abnormal                      

DATE/TIME PERFORMED: JUL 03, 2003@13:45  

TEST

/es/ CPUSER1, ONE                                                   

MEDICAL SPECIALIST                                                        

Signed: 03/12/2004 11:04                                                  

--------------------------------------------------------------------------------

       TITLE: PFT                                                      

DATE OF NOTE: JUL 03, 2003@13:53     ENTRY DATE: JUL 03, 2003@13:53         

      AUTHOR:                      EXP COSIGNER:                           

     URGENCY:                            STATUS: UNDICTATED                    

PROCEDURE SUMMARY CODE:                               

DATE/TIME PERFORMED: JUL 03, 2003@13:45  

--------------------------------------------------------------------------------

       TITLE: PFT                                                      

DATE OF NOTE: JUL 03, 2003@14:34:32  ENTRY DATE: JUL 03, 2003@14:34:32      

      AUTHOR:                      EXP COSIGNER:                           

     URGENCY:                            STATUS: UNDICTATED                    

PROCEDURE SUMMARY CODE:                               

DATE/TIME PERFORMED: JUL 03, 2003@13:45  

================================================================================

NOTE: Images are associated with this procedure.

      Please use Imaging Display to view the images.

Here is an example of a Medicine Report.

Pg. 1                         HINES VAMC               05/03/04 13:30

            ELECTROPHYSIOLOGY REPORT - RELEASED ON-LINE VERIFIED              

CPPATIENT1, TEN    000-00-0110                     DOB: FEB 3,1943  (61) 3AS 

- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 

DATE/TIME:   6/30/03@10:40

MEDICAL PATIENT:   CPPATIENT1, TEN
WARD/CLINIC:   CARDIAC CLINIC

CARDIAC DX:   AORTIC STENOSIS

REASON FOR STUDY:   AGINA PROBLEMS.

SYMPTOM: 

  UNSTABLE ANGINA

RISK FACTOR: 

  CARDIOMEGALY (X-RAY)

ARRHYTHMIA DX: 

  HEART BLOCK-MOBITZ II

HX: 

  This is the HX text.

 - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -

                  R e p o r t   R e l e a s e   S t a t u s

Current            Date     Person Who

Report             Status   Last Changed             Date of            Report

Status             Changed  The Status                Entry             Version

===============================================================================

RELEASED ON-LINE VERIFIED

                   6/30/03  NA JACKSONS            6/30/03            1 of 1

Procedures XE "Medicine/CP Reports:Procedures" 
This report component lists Medicine and CP procedures for a selected patient visiting your facility, who is typically seen at another facility.  You can view a patient’s data from a remote facility, which is called remote data viewing.  
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The procedures are listed in chronological order within a specified date range and a maximum number of occurrences (Max/site).  The name of the report, selected date range and maximum number of occurrences (Max/site) appear above the procedure list.  
Procedure Date/Time

  09/02/2003 16:30

Medicine Procedure Name     

  ECHO

Summary

  No Summary

Detailed Report

                     :    

                         -------------------------------------------------------------

                                TITLE: ECHO EXAM                                  

                                      DATE OF NOTE: MAR 05, 2002@08:53     ENTRY

                         DATE: MAR 05, 2002@08:53:14      

                               AUTHOR: CPUSER1, ONE        EXP COSIGNER:         

                              URGENCY:                            STATUS:

                         COMPLETED                     

                         PROCEDURE SUMMARY CODE: Abnormal                      

                         DATE/TIME PERFORMED: MAR 04, 2002@12:21  

                         test 

                         /es/ CPUSER1, TWO                                      

                                         MEDICAL SPECIALIST                       

                                                         Signed: 03/05/2002 12:06 

                         -------------------------------------------------------------

                                TITLE: ECHO EXAM                                  

                                      DATE OF NOTE: SEP 02, 2003@15:48:49  ENTRY

                         DATE: SEP 02, 2003@15:48:49      

                               AUTHOR:                      EXP COSIGNER:         

                              URGENCY:                            STATUS:

                         UNDICTATED                    

                         PROCEDURE SUMMARY CODE:                               

                         DATE/TIME PERFORMED: SEP 02, 2003@16:30  

                         ================================================================================

Facility: SUPPORT ISC

===============================================================================

Configuring the Medicine Report to Display in CPRS XE "Medicine/CP Reports:Configuring" 

The Medicine View file (#690.2) controls which fields are displayed in the Medicine reports except for the Procedures (local only) report.  You can add and delete fields in the procedure type view template, which is located in the Medicine View file.  When you edit the template, the Medicine reports within the Procedures (local only), Medicine/CP tree listing and the Health Summary reports are affected.

If the report does not display, be sure the procedure that you want to display is entered in the PROCEDURE field for the appropriate template.

You can use FileMan to add fields to the Medicine View file.  The following are examples of adding a multiple field and a single field to a print template.

· Here is an example of how to add field #37.1, which is a sub-file (multiple field) to the Full GI Medicine View entry.

VA FileMan 22.0

Select OPTION: 1  ENTER OR EDIT FILE ENTRIES

INPUT TO WHAT FILE: HEALTH SUMMARY COMPONENT// 690.2  MEDICINE VIEW

                                          (36 entries)

EDIT WHICH FIELD: ALL// <RET>
Select MEDICINE VIEW PRINT VIEW TEMPLATE NAME: Full GI       ENDOSCOPY/CONSULT

PRINT VIEW TEMPLATE NAME: Full GI// <RET>
PRIMARY FILE: ENDOSCOPY/CONSULT// <RET>
Select FIELD NUMBER: 203// <RET>
  FIELD NUMBER: 203// <RET>
  ORDER ENTRY USAGE: UNKNOWN// <RET>
  ASTM: <RET>
  VALUE TYPE: <RET>
  UNITS: <RET>
  RANGES: <RET>
  SEG: <RET>
  PIECE: <RET>
  CODING METHOD: <RET>
Select FIELD NUMBER: 37.1
  Are you adding '37.1' as a new FIELD NUMBER (the 46TH for this MEDICINE VIEW)? No// y  (Yes)

   FIELD NUMBER ASTM: <RET>
  ORDER ENTRY USAGE: <RET>
  ASTM: <RET>
  VALUE TYPE: <RET>
  UNITS: <RET>
  RANGES: <RET>
  SEG: <RET>
  PIECE: <RET>
  CODING METHOD: <RET>
Select FIELD NUMBER: <RET>
Select SUB-FILE: 699.19// <RET>
  SUB-FILE: 699.19// <RET>
  Select SUB-FIELD: .01// <RET>
    SUB-FIELD: .01// <RET>
    ORDER ENTRY USAGE: <RET>
    ASTM: <RET>
    VALUE TYPE: <RET>
    UNITS: <RET>
    RANGES: <RET>
    SEG: <RET>
    PIECE: <RET>
    CODING: <RET>
  Select SUB-FIELD: <RET>
Select SUB-FILE: 699.04
  Are you adding '699.04' as a new SUB-FILE (the 23RD for this MEDICINE VIEW)? No// Y  (Yes)

  Select SUB-FIELD: .01
  Are you adding '.01' as a new SUB-FIELD (the 1ST for this SUB-FILE)? No// Y
  (Yes)

   SUB-FIELD ASTM: <RET>
    ORDER ENTRY USAGE: <RET>
    ASTM: <RET>
    VALUE TYPE: <RET>
    UNITS: <RET>
    RANGES: <RET>
    SEG: <RET>
    PIECE: <RET>
    CODING: <RET>
  Select SUB-FIELD: <RET>
Select SUB-FILE: <RET>
Select PROCEDURE: GEN// ?
    Answer with PROCEDURE

   Choose from:

   COL   

   EGD   

   ERC   

   GEN   

   GIENDO   

   LAP   

   LV PARAC   

   PARAC   

   VAS   

        You may enter a new PROCEDURE, if you wish

 Answer with PROCEDURE/SUBSPECIALTY NAME, or GLOBAL LOCATION, or

     TYPE OF PROCEDURE, or PRINT NAME

 Do you want the entire 83-Entry PROCEDURE/SUBSPECIALTY List? N  (No)

Select PROCEDURE: GEN// <RET>
Type: Full// <RET>
Select MEDICINE VIEW PRINT VIEW TEMPLATE NAME: <RET>
· Here is an example of how to add a single field #204.5 to the Full GI Medicine View file (#690.2).

Select MEDICINE VIEW PRINT VIEW TEMPLATE NAME:    Full GI     ENDOSCOPY/CONSULT

PRINT VIEW TEMPLATE NAME: Full GI// <RET>
PRIMARY FILE: ENDOSCOPY/CONSULT// <RET>
Select FIELD NUMBER: 37.1// <RET>
  FIELD NUMBER: 37.1// <RET>
  ORDER ENTRY USAGE: <RET>
  ASTM: <RET>
  VALUE TYPE: <RET>
  UNITS: <RET>
  RANGES: <RET>
  SEG: <RET>
  PIECE: <RET>
  CODING METHOD: <RET>
Select FIELD NUMBER: 204.5
  Are you adding '204.5' as a new FIELD NUMBER (the 47TH for this MEDICINE VIEW)? No// Y  (Yes)

   FIELD NUMBER ASTM: <RET>
  ORDER ENTRY USAGE: <RET>
  ASTM: <RET>
  VALUE TYPE: <RET>
  UNITS: <RET>
  RANGES: <RET>
  SEG: <RET>
  PIECE: <RET>
  CODING METHOD: <RET>
Select FIELD NUMBER: <RET>
Select SUB-FILE: 699.04// <RET>
  SUB-FILE: 699.04// <RET>
  Select SUB-FIELD: .01// <RET>
    SUB-FIELD: .01// <RET>
    ORDER ENTRY USAGE: <RET>
    ASTM: <RET>
    VALUE TYPE: <RET>
    UNITS: <RET>
    RANGES: <RET>
    SEG: <RET>
    PIECE: <RET>
    CODING: <RET>
  Select SUB-FIELD: <RET>
Select SUB-FILE: <RET>
Select PROCEDURE: GEN// <RET>
Type: Full// <RET>
Select MEDICINE VIEW PRINT VIEW TEMPLATE NAME: <RET>
6. 
Glossary XE "Glossary" 
Access Code   A unique sequence of characters known by and assigned only to the user, the system manager and/or designated alternate(s).  The access code (in conjunction with the verify code) is used by the computer to identify authorized users.

Action   A functional process that a clinician or clerk uses in the TIU computer program.  For example, “Edit” and “Search” are actions.  Protocol is another name for Action.

ADP Coordinator/ADPAC/Application Coordinator   Automated Data Processing Application Coordinator.  The person responsible for implementing a set of computer programs (application package) developed to support a specific functional area such as clinical procedures, PIMS, etc.

Application   A system of computer programs and files that have been specifically developed to meet the requirements of a user or group of users. 

Archive   The process of moving data to some other storage medium, usually a magnetic tape, and deleting the information from active storage in order to free-up disk space on the system.

ASU   Authorization/Subscription Utility, an application that allows sites to associate users with user classes, allowing them to specify the level of authorization needed to sign or order specific document types and orderables.  ASU is distributed with TIU in this version; eventually it will probably become independent, to be used by many VistA packages.

Attachments   Attachments are files or images stored on a network share that can be linked to the CP study.   CP is able to accept data/final result report files from automated instruments. The file types that can be used as attachments are the following:



.txt 
Text files


.rtf
Rich text files


.jpg
JPEG Images


.jpeg
JPEG Images


.bmp
Bitmap Images


.tiff
TIFF Graphics (group 3 and group 4 compressed and uncompressed types)



.pdf
Portable Document Format


.html
Hypertext Markup Language 

.DOC (Microsoft Word files) are not supported. Be sure to convert .doc files to .rtf or to .pdf format.
Background Processing   Simultaneous running of a "job" on a computer while working on another job.  Examples would be printing of a document while working on another, or the software might do automatic saves while you are working on something else.

Backup Procedures   The provisions made for the recovery of data files and program libraries and for restart or replacement of ADP equipment after the occurrence of a system failure.

Boilerplate Text   A pre-defined TIU template that can be filled in for Titles, Speeding up the entry process.  TIU exports several Titles with boilerplate text which can be modified to meet specific needs; sites can also create their own.

Browse   Lookup the file folder for a file that you would like to select and attach to the study. (e.g., clicking the “...” button to start a lookup).

Bulletin   A canned message that is automatically sent by MailMan to a user when something happens to the database.

Business Rule   Part of ASU, Business Rules authorize specific users or groups of users to perform specified actions on documents in particular statuses (e.g., an unsigned TIU note may be edited by a provider who is also the expected signer of the note).

Class   Part of Document Definitions, Classes group documents.  For example, “CLINICAL PROCEDURES” is a class with many kinds of Clinical Procedures notes under it.  Classes may be subdivided into other Classes or Document Classes.  Besides grouping documents, Classes also store behavior which is then inherited by lower level entries.
Consult   Referral of a patient by the primary care physician to another hospital service/ specialty, to obtain a medical opinion based on patient evaluation and completion of any procedures, modalities, or treatments the consulting specialist deems necessary to render a medical opinion.

Contingency Plan   A plan that assigns responsibility and defines procedures for use of the backup/restart/recovery and emergency preparedness procedures selected for the computer system based on risk analysis for that system.

CP   Clinical Procedures.

CP Definition   CP Definitions are procedures within Clinical Procedures.


CP Procedure   A procedure who’s data is stored in the Clinical Procedures package.

CP Study   A CP study is a process created to link the procedure result from the medical device or/and to link the attachments browsed from a network share to the procedure order.
CPRS   Computerized Patient Record System.  A comprehensive VistA program, which allows clinicians and others to enter and view orders, Progress Notes and Discharge Summaries (through a link with TIU), Problem List, view results, reports (including health summaries), etc.

Data Dictionary   A description of file structure and data elements within a file.

Device   A hardware input/output component of a computer system (e.g., CRT, printer).

Document Class   Document Classes are categories that group documents (Titles) with similar characteristics together.  For example, Cardiology notes might be a Document Class, with Echo notes, ECG notes, etc. as Titles under it.  Or maybe the Document Class would be Endoscopy Notes, with Colonoscopy notes, etc. under that Document Class.

Document Definition   Document Definition is a subset of TIU that provides the building blocks for TIU, by organizing the elements of documents into a hierarchy structure.  This structure allows documents (Titles) to inherit characteristics (such as signature requirements and print characteristics) of the higher levels, Class and Document Class.  It also allows the creation and use of boilerplate text and embedded objects.

Edit   Used to change/modify data typically stored in a file.

Field   A data element in a file. 

File   The M construct in which data is stored for retrieval at a later time.  A computer record of related information.

File Manager or FileMan   Within this manual, FileManager or FileMan is a reference to VA FileMan.  FileMan is a set of M routines used to enter, edit, print, and sort/search related data in a file, a database.  

File Server   A machine where shared software is stored.

Gateway   The software that performs background processing for Clinical Procedures. 

Global   An M term used when referring to a file stored on a storage medium, usually a magnetic disk. 

GUI   Graphical User Interface - a Windows-like screen that uses pull-down menus, icons, pointer devices, and other metaphor-type elements that can make a computer program more understandable, easier to use, allow multi-processing (more than one window or process available at once), etc.

Interpreter   Interpreter is a user role exported with USR*1*19 to support the Clinical Procedures Class.  The role of the Interpreter is to interpret the results of a clinical procedure.  Users who are authorized to interpret the results of a clinical procedure are sent a notification when an instrument report and/or images for a CP request are available for interpretation.  Business rules are used to determine what actions an interpreter can perform on a document of a specified class, but the interpreter themselves are defined by the Consults application.  These individuals are ‘clinical update users’ for a given consult service.  

IRMS   Information Resource Management Service.

Kernel   A set of software utilities.  These utilities provide data processing support for the application packages developed within the VA.  They are also tools used in configuring the local computer site to meet the particular needs of the hospital.  The components of this operating system include: MenuMan, TaskMan, Device Handler, Log-on/Security, and other specialized routines.

LAYGO   An acronym for Learn As You Go.  A technique used by VA FileMan to acquire new information as it goes about its normal procedure.  It permits a user to add new data to a file.

M   Formerly known as MUMPS or the Massachusetts (General Hospital) Utility Multi-Programming System.  This is the programming language used to write all VistA applications.

MailMan   An electronic mail, teleconferencing, and networking system.


Medicine Procedure   A procedure who’s data is stored in the Medicine package.

Menu   A set of options or functions available to users for editing, formatting, generating reports, etc.

Module   A component of a software application that covers a single topic or a small section of a broad topic.

Namespace   A naming convention followed in the VA to identify various applications and to avoid duplication.  It is used as a prefix for all routines and globals used by the application. 

Network Server Share   A machine that is located on the network where shared files are stored.

Notebook   This term refers to a GUI screen containing several tabs or pages.

OI   Office of Information, formerly known as Chief Information Office Field Office, Information Resource Management Field Office, and Information Systems Center.

Option   A functionality that is invoked by the user.  The information defined in the option is used to drive the menu system.  Options are created, associated with others on menus, or given entry/exit actions. 

Package   Otherwise known as an application.  A set of M routines, files, documentation and installation procedures that support a specific function within VistA.

Page   This term refers to a tab on a GUI screen or notebook.

Password   A protected word or string of characters that identifies or authenticates a user, a specific resource, or an access type (synonymous with Verify Code).

Pointer   A special data type of VA FileMan that takes its value from another file.  This is a method of joining files together and avoiding duplication of information.  

Procedure Request   Any procedure (EKG, Stress Test, etc.) which may be ordered from another service/specialty without first requiring formal consultation.

Program   A set of M commands and arguments, created, stored, and retrieved as a single unit in M.

Queuing   The scheduling of a process/task to occur at a later time.  Queuing is normally done if a task uses up a lot of computer resources.

RAID  Redundant Array of Inexpensive Drives.  Imaging uses this to store images.


Remote Data Viewing   The act of viewing a patient’s data from a remote facility.

Result   A consequence of an order.  Refers to evaluation or status results.  When you use the Complete Request (CT) action on a consult or request, you are transferred to TIU to enter the results.

<RET>   Carriage return.

Routine   A set of M commands and arguments, created, stored, and retrieved as a single unit in M.

Security Key   A function which unlocks specific options and makes them accessible to an authorized user.

Sensitive Information   Any information which requires a degree of protection and which should be made available only to authorized users.

Site Configurable   A term used to refer to features in the system that can be modified to meet the needs of each site.

Software   A generic term referring to a related set of computer programs.  Generally, this refers to an operating system that enables user programs to run.

Status Symbols   Codes used in order entry and Consults displays to designate the status of the order.

Task Manager or TaskMan   A part of Kernel which allows programs or functions to begin at specified times or when devices become available.  See Queuing.

Title   Titles are definitions for documents.  They store the behavior of the documents which use them.

TIU   Text Integration Utilities.

User   A person who enters and/or retrieves data in a system, usually utilizing a CRT.

User Class   User Classes are the basic components of the User Class hierarchy of ASU (Authorization/Subscription Utility) which allows sites to designate who is authorized to do what to documents or other clinical entities.

User Role   User Role identifies the role of the user with respect to the document in question (e.g., Author/Dictator, Expected Signer, Expected Cosigner, Attending Physician, etc.).

Utility   An M program that assists in the development and/or maintenance of a computer system.

Verify Code   A unique security code which serves as a second level of security access.  Use of this code is site specific; sometimes used interchangeably with a password.

VistA   Veterans Health Information Systems and Technology Architecture.

Workstation   A personal computer running the Windows 9x or NT operating system.
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